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Introduction

The QACenter Installation and Configuration Guide provides information and procedures 

to install the following QACenter products:

� QARun

� QADirector (32-bit version)

� WebCheck

� QALoad

� QADirector (16-bit version)

� QATrack

� Compuware Central.

This guide also provides information on how to install temporary and permanent licenses 

for those products. Please note that Compuware Central does not require a license. If you 

are only installing Compuware Central you may skip the licensing chapters and proceed 

to Chapter 8, “Installing Compuware Central”.

Who Should Read This Guide

The QACenter Installation and Configuration Guide is intended for administrators who 

will be installing QACenter products. This guide does not contain reference or usage 

information. You can find that information in your product’s online help facility and 

documentation set.

Compuware assumes that you have some familiarity with basic Microsoft Windows 

navigation. If this is not the case, familiarize yourself with the documentation for 

Microsoft Windows before reading this guide.

Note

To install TrackRecord, refer to the TrackRecord Installation Guide. For information and 

support for QATrackRecord, contact QACenter Technical Support at 1-800-538-7822.
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Related Publications

In addition to the QACenter Installation and Configuration Guide and the TrackRecord 

Installation Guide, each QACenter product includes its own online help system and 

documentation set.

Viewing and Printing Online Books

QACenter’s online books are provided in PDF format, so you need Adobe Acrobat Reader 

3.0 or above to view them. To install the Adobe Acrobat Reader, click Install Adobe 

Acrobat Reader on the QACenter CD, or go to Adobe’s Web site at www.adobe.com.

You can access the PDF versions of the QACenter Installation and Configuration Guide 

and the TrackRecord Installation Guide from an installation bookshelf available from the 

QACenter CD browser.

You can access each product’s online books from the product’s documentation bookshelf. 

For example, if you have QARun installed and you wish to access the QARun User’s 

Guide, click the taskbar’s Start button and choose Programs>Compuware>QARun 

>QARun Books>QARun Bookshelf. Select the QARun User’s Guide from the list.

Because PDF is based on PostScript, a PostScript printer is the most reliable way to print 

the online books. In most cases, you can also print PDF files to PCL printers. If you 

cannot print the PDF files to your printer, refer to Adobe’s web site at www.adobe.com 

for troubleshooting information.

World Wide Web Information 

To access Compuware Corporation’s site on the World Wide Web, point your browser at 

http://www.compuware.com. The Compuware site provides a variety of product and 

support information.

FrontLine Support Web Site: You can access online technical support for Compuware 

products via our FrontLine support Web site at http://frontline.compuware.com. 

FrontLine provides fast access to critical information about your QACenter product. You 

can read or download documentation, frequently asked questions, and product fixes, or e-

mail your questions or comments. The first time you access FrontLine, you are required 

to register and obtain a password.
 

http://www.adobe.com
http://www.compuware.com
http://www.adobe.com
http://frontline.compuware.com
http://frontline.compuware.com
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Getting Help 

At Compuware, we strive to make our products and documentation the best in the 

industry. Feedback from our customers helps us maintain our quality standards. If you 

need support services, please obtain the following information before calling 

Compuware’s 24-hour product support hotline:

� The name, release (version), and build number of the QACenter product. This infor-

mation is displayed when you select the About command from your product’s Help 

menu. The name and release are also on the covers of the product documentation.

� Installation information, including installed options, whether the product uses local 

or network databases, whether it is installed in the default directories, whether it is a 

standalone or network installation, and whether it is a client or server installation.

� Environment information, such as the operating system and release on which the 

product is installed, memory, hardware/network specifications, and the names and 

releases of other applications that were running.

� The location of the problem in the QACenter product software, and the actions 

taken before the problem occurred.

� The exact product error message, if any.

� The exact application, licensing, or operating system error messages, if any.

� Your Compuware client, office, or site number, if available.

QACenter Technical Support

Compuware Corporation

31440 Northwestern Highway 

Farmington Hills, MI 48334-2564

1-800-538-7822
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Chapter 1.   Installing a Temporary License

This chapter describes how to install a temporary license for a Compuware product that 

you are installing for the first time. A temporary license key is provided on a license 

diskette included in the product’s distribution package.

The temporary license that was delivered with your product is valid for a limited time; it 

allows you to use the product until you obtain a permanent license. To extend the duration 

of a temporary license, contact your Compuware sales representative. If you have already 

received your permanent license key, you do not need to install a temporary license. 

Instead, install your permanent license according to the procedure in Chapter 9, 

“Installing a Permanent License” that is applicable to your license type.

To install your temporary license, follow the appropriate procedure for your platform:

� “Installing a Temporary License on Windows 95, 98, or NT” on page 1-1

� “Installing a Temporary License on UNIX or Windows 3.1x” on page 1-4.

Installing a Temporary License on Windows 95, 98, or NT

Before you begin installing you temporary license, locate the temporary license diskette 

that was in your distribution package. You should have received one diskette for each 

product you ordered. If you ordered the TestPack, however, you should have received a 

single diskette containing a file named testpkxx.dat. This file combines the temporary 

license keys for the TestPack products: QARun, QADirector, and TrackRecord.

Note

You must install a valid license key before you install a QACenter product. Please note 

that Compuware Central does not require a license. If you are only installing Compuware 

Central proceed to Chapter 8, “Installing Compuware Central”.

Note

If you are installing a temporary license in a computer with Windows 3.1x, see “Installing 

a Temporary License on UNIX or Windows 3.1x” on page 1-4.
 



1-2     QACenter Installation and Configuration Guide
To install your temporary license on a Windows machine you will use the License Admin-

istration Utility (LAU), which is located on the QACenter CD-ROM.

1. If necessary, create a directory on the drive where your operating system is installed 

called  \Program Files\Compuware\License (or  \cpwr for 16-bit products). This 

directory may have already been created for another Compuware product.

2. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products.

3. Click Run License Administration Utility. The LAU opens.

4. On the LAU main window, click the Install License button. The Install License 

Files dialog box appears.

5. Click the Browse button next to the Product License File field to navigate to the 

temporary license file. This file should be on the temporary license diskette that 

came with your Compuware product. Click Open.

6. Click the Browse button next to the Master License File field to navigate to the 

master license file. This file is called license.dat and is normally located in the 

directory \Program Files\Compuware\License (or \cpwr). Click Open.

If you do not have a license file for another Compuware product, click Browse and 

navigate to the directory \program files\compuware\license (or \cpwr) that you cre-

ated in Step 1 and create a new file by typing license.dat in the File Name field. 

Click Open to select the new license file as your master file.

7. When you have selected the correct product and master license files, click the 

Install License button. This installs the product license file to your master license 

file.Once it is installed, click OK.

8. Check that the environment variable called LM_LICENSE_FILE is set. If it is not 

set, use the appropriate procedure below to set it.
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For Windows 95 or 98:

a. From the Tools menu on the LAU main window, choose Set. The Set License 

File Variable dialog box displays the current environment variable setting.

b. If the variable LM_LICENSE_FILE is not set to the license.dat file, click the 

Browse button and navigate to the appropriate license file. The file should be 

located in \Program Files\Compuware\License. Click Open to add the file to 

the LM_LICENSE_FILE variable.

c. Click OK to save your changes. LAU sets the entry LM_LICENSE_FILE in 

your autoexec.bat file.

d. When prompted to create a backup of your autoexec.bat file, click Yes. The 

backup file is named autoexec.0XX (where X=1 through 99.)

e. When you are finished, reboot the computer for the changes to take effect.

For Windows NT:

In Windows NT, you have to set the environment variable from the System Proper-

ties dialog box in the Windows control panel.

a. Exit the QACenter CD-ROM.

b. From the Start menu, select Settings>Control Panel>System. On the System 

dialog box, click the Environment tab.

c. In the Variable field, type LM_LICENSE_FILE.

d. In the Value field, type the fully qualified path of your license file. For exam-

ple,  C:\Program Files\Compuware\License\license.dat. Click the Set button.

e. When you are finished, reboot the computer for the changes to take effect.

9. Install your QACenter product(s). Refer to the product-specific installation chapter 

in this guide for more information:

• To install QARun, see Chapter 2, “Installing QARun”

• To install QADirector 4.3, see Chapter 3, “Installing QADirector 4.3”

• To install WebCheck, see Chapter 4, “Installing WebCheck”

• To install QALoad, see Chapter 5, “Installing QALoad”

• To install QADirector 2.3, see Chapter 6, “Installing QADirector 2.3”

• To install QATrack, see Chapter 7, “Installing QATrack”

• To install Compuware Central, Chapter 8, “Installing Compuware Central”

• To install TrackRecord, refer to the TrackRecord Installation Guide
 



1-4     QACenter Installation and Configuration Guide
Installing a Temporary License on UNIX or Windows 3.1x

1. Locate the temporary license diskette in your distribution package. You should have 

received one diskette for each product you ordered. If you ordered the TestPack, 

however, you should have received a single diskette containing a file named qat-

est.dat. This file combines the temporary license keys for the TestPack products: 

QARun, QADirector, and TrackRecord.

2. Check to see if a license file already exists on the machine on which you intend to 

install the product. The license file should be named license.dat. It is normally 

located in the directory �cpwr/license (or \cpwr for Windows) on the drive where a 

Compuware product is installed.

• If a license.dat file does not exist for another product, go to Step 3.

• If a license.dat file already exists for another product, go to Step 4. 

3. On the drive where your operating system is installed, create a directory called 

�cpwr/license (or \cpwr for Windows).

4. Copy the temporary license string from the license diskette to your license.dat file:

• If a license file did not exist for another product, copy the file from the diskette 

into the directory you created in Step 3. Then, rename the file license.dat.

• If a license file already exists, open that file in a text editor such as Pico or 

Notepad. Copy the new temporary license key (the FEATURE and VENDOR 

lines) to the end of the file, as highlighted in the following example:

:

5. Save your changes to the license.dat file.

6. Repeat steps 4 and 5 for each product you wish to install.

7. Check that the LM_LICENSE_FILE environment variable is set. This variable may 

have already been set. If it is not set, use the appropriate procedure below to set it. 

FEATURE QATrack compuware 1.400 10-sep-1998 10 6C74309CB84A9F07C5ED\
VENDOR_STRING=989898;0;PERM ck=12
FEATURE QARun compuware 04.600 12-jan-1999 0 1CF2086C1D9766696EDO\
VENDOR_STRING=989898;0;TRIAL HOSTID=DEMO
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These procedures assume that license.dat is located in the directory \cpwr 

(Windows) or �cpwr/license (UNIX).

For Windows 3.1x:

Using a text editor, open the autoexec.bat file and add the following line:

SET LM_LICENSE_FILE=c:\cpwr\license.dat

Reboot the machine for these changes to take effect.

For UNIX:

Set the LM_LICENSE_FILE environment variable in your user profile to point to 

the directory where your license.dat file resides ( �cpwr/license).

8. Install your QACenter product(s). Refer to the product-specific installation chapter 

in this guide for more information:

• To install QARun, see Chapter 2, “Installing QARun”

• To install QADirector 4.3, see Chapter 3, “Installing QADirector 4.3”

• To install WebCheck, see Chapter 4, “Installing WebCheck”

• To install QALoad, see Chapter 5, “Installing QALoad”

• To install QADirector 2.3, see Chapter 6, “Installing QADirector 2.3”

• To install QATrack, see Chapter 7, “Installing QATrack”

• To install Compuware Central, Chapter 8, “Installing Compuware Central”

• To install TrackRecord, refer to the TrackRecord Installation Guide

To extend the duration of a temporary license, contact your Compuware sales represen-

tative.
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Chapter 2.   Installing QARun

This chapter explains QARun’s installation processes. It details system requirements, 

installation, network configurations, and database selection. There are two types of 

QARun installations: a full installation and a client installation. These are both explained 

in detail in this chapter. This chapter is divided into the following sections:

� System Requirements — Requirements for running QARun.

� QARun Installation — Instructions for installing QARun as a full installation or as 

a client. It also explains QARun’s network installation considerations.

� Starting QARun and Connecting to a Database — Instructions for starting 

QARun and connecting to the appropriate database.

System Requirements
The amount of space required to run QARun is, of course, dependent on the amount of 

testing data you intend to generate. The following system requirements are the minimum 

suggested specifications to successfully run QARun:

� 133-MHz Pentium PC or above (166 MHz or above recommended)

� Windows 95, Windows 98, Windows 2000 or Windows NT 4.0 (with Service 

Pack 4) or above with 32 MB of RAM

� 100 MB of hard-drive space for local installations; 5 MB of space for network 

installations

� SVGA (800 x 600) monitor and adapter

� Microsoft Access database (supplied with QARun), Oracle Version 7.3 or 8 (and a 

separate server to store the Oracle repository), or SQL Server 6.5 or 7.0 (and a sepa-

rate server to store the SQL Server repository).

Note

Before you install QARun, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 9, “Installing a Permanent License” for 

instructions on installing a license.
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QARun Installation

This section explains QARun’s installation processes and network installation consider-

ations. If you are a first-time QARun user, you should evaluate your site’s specific usage 

requirements to determine the most appropriate installation procedure. There are two 

types of installations: full installations and client installations.

A full installation generates a complete set of QARun programs and associated files on 

the specified drive. You should complete a full installation if you want to:

� Use QARun on your workstation without logging on to a network.

� Install network clients that share the central network QARun application.

A client installation copies specific application files to your local drive and shares other 

files with the network. Client installations share working files and executable files with 

the network. Consequently, before you can successfully install a network client, you must 

complete at least one full installation on the network.

Although a client installation does place some files on your local drive, it requires signif-

icantly less local disk space than a full workstation installation. You should implement a 

client installation if you want to:

� Share resources (such as scripts, checks, or events) in one repository

� Centrally manage your QARun system

� Move workstations

Please review “System Requirements” on page 2-1 to ensure that QARun will install 

and operate properly at your site, and then proceed to “Performing a Full Installation” on 

page 2-2.

Performing a Full Installation

If you have a license to use QARun on one or more computers, you can complete a full 

installation on each workstation, or client workstations can access a central QARun 

network installation. If you intend to run QARun in a shared Windows environment, you 

must still complete a full installation on the server.

Note

Before you install QARun, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 9, “Installing a Permanent License” for 

instructions on installing a license.
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To perform a full installation, complete the following steps:

1. Before proceeding with the QARun installation, Compuware recommends that you 

review the QARun Release Announcement. This document details new release fea-

tures and functionality that may impact or enhance your site’s usage of QARun.

2. Insert the QACenter CD into the CD-ROM drive. 

The QACenter setup should automatically start. If it does not, use Windows 

Explorer to navigate to the setup program.

3. Click Install QACenter Products.

4. Click Install QARun. The QARun Software License Agreement dialog box 

displays.

If QARun cannot verify the location of your license key, a dialog box may appear 

prompting you to start the License Administration Utility (see Chapter 1, “Installing 

a Temporary License” or Chapter 9, “Installing a Permanent License”).

5. Read the software license agreement and click the Yes button to accept the terms of 

the agreement.

The Choose QARun Location dialog box displays:

6. Select a location for the QARun installation.

Note

QARun requires that Microsoft’s DCOM (Distributed Component Object Model) and 

Microsoft’s Data Access Components (MDAC) sets are installed on your workstation. If 

the QARun installation program does not detect DCOM (Windows 95 only) and MDAC on 

your system, you will be prompted to automatically install them. After installing the 

necessary DCOM or MDAC components, your system will reboot and the QARun 

installation program will begin.
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• By default, QARun installs in the local folder named 

C:\Program Files\Compuware\QARun.

• To specify a different local path or to install to a network, type the path name in 

the field or click the Browse button and select an existing directory.

If you are upgrading to a new release, select the current location of QARun.

If you intend to install network clients, you must install this copy of QARun to a 

network folder where all network clients have read access.

7. Click Next. The Select QARun Components dialog box displays:

This dialog box allows you to install specific QARun components. To receive fur-

ther information related to a specific component, highlight the component and view 

a detailed description in the Description area.

If the selected component has further installation options, the Change button in the 

Description area is enabled. You can click the Change button to select the desired 

installation options and, then, click OK to return to the Select QARun Components 

dialog box.

8. Select the component check boxes that you want to install.

Note

If you are installing to a network and will perform future client installations, you must 

select the The Client Installation check box. You must also have write access to the 

shared Windows folder in order to complete the first full installation.

Note

If you intend to test SAP or Java applications, you must select the appropriate component 

check box. Selecting these options automatically installs the additional support necessary 

to test in these environments. 
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9. Click Next. The QARun Shortcut Folder dialog box displays. Verify the location 

where the program icons will be added.

10. Click Next. The Start Copying Files dialog box displays and allows you to review 

your installation selections.

11. Click Next to begin the actual installation. 

Follow the prompts on the Setup Wizard to help you make installation decisions. 

For Windows 95 and Windows 98, QARun must write some information to the 

workstation’s Autoexec.bat file. QARun displays the following dialog:

• If you select the Make updates directory to “Autoexec.bat” option, QARun 

will write the necessary path information directly into your Autoexec.bat file. 

The changes will take affect after you re-boot the system.

When QARun updates the Autoexec.bat file, a back up of the original 

Autoexec.bat file is automatically saved to a file named Autoexec.qar.

• If you select the Update “Autoexec.txt” in the QARun directory, the applica-

ble changes will be entered in the Autoexec.txt file. You can then copy the text 

and insert it manually into your Autoexec.bat file.

• If you select the Do not make any updates option, no changes will be made, 

and you will not be able to successfully start the QARun program.

12. Click Next to complete the installation.

After the QARun setup program completes, you may install additional QACenter 

products. After you are finished installing QACenter products, exit QACenter and restart 

the computer.
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Where To Go Next

A complete copy of QARun now resides on your local drive or on the network drive. 

� If you installed to a network and are ready to establish network clients, proceed to 

“Performing a Client Installation” on page 2-6.

� If you are ready to begin using QARun, proceed to “Starting QARun and Connect-

ing to a Database” on page 2-7.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD’s Products Installation dialog box and click the Get Acrobat button 

to launch Adobe’s installation program.

You must have Adobe Acrobat Reader installed to view QARun’s books online in 

PDF format.

Performing a Client Installation

If you are working with limited storage space on individual workstations, you should 

consider performing client installations. Installing a client copy of QARun requires that 

some files reside on the local disk, but the required disk space is much less than that 

required for a full installation. Installing a client copy also allows you to centrally manage 

your QARun system by using a central repository for all data.

Client installations can only be performed after a QARun full installation has been 

performed on the network server (the component The Client Install check box must be 

selected during this installation). 

You must complete a client installation for each workstation that will run from the shared 

QARun installation on the network. Because the client installation’s setup is run from the 

QARun Client folder on the network, the client workstation must have read access to this 

folder during installation.

To install QARun in a shared Windows environment, complete the following steps:

1. If you have not done so, complete a full installation as described on page 2-2.

2. Add each client user to the QARun User Table so they can log into the shared 

database (refer to the QARun User’s Guide for more information).

3. Ensure that each client workstation has read access to the network directory where 

QARun is installed. 

Each client workstation will also need write access to the network directory where 

the QARun database is stored.

Note

Ensure that the component The Client Install check box is selected during the full 

installation.
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4. From the client workstation, locate the network installation’s QARun Client folder 

and run the setup.exe program (C:\Program Files\Compuware\QARun\Client, by 

default). The setup’s Welcome dialog box displays.

5. Click Next from the Welcome dialog box. The Start Copying Files dialog box 

displays.

6. Ensure that the components listed on the Start Copying Files dialog box are the 

components you intend to install and click Next to begin the installation.

Where To Go Next

A client copy of QARun now resides on your local drive.

� If you have not done so, you must install a temporary license key on each client 

machine before you will be able to start QARun. See “Installing a Temporary 

License” on page 1-1 for details on entering the temporary license key.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD’s Products Installation dialog box and click the Get Acrobat button 

to launch Adobe’s installation program. You must have Adobe Acrobat Reader 

installed in order to view QARun’s books online in PDF format.

� If you are ready to begin using QARun, proceed to “Starting QARun and Connect-

ing to a Database” on page 2-7.

Starting QARun and Connecting to a Database

QARun’s architecture is based on a test asset repository, or database. This multi-user 

repository offers centralized control of users and system access rights. This section 

provides details on connecting to the appropriate database and changing the Adminis-

tration password.

Before you use QARun, you need to determine the type of database you will be using. Use 

the following procedures to connect to the appropriate database type:

� “Starting QARun and Connecting to a Microsoft Access Database” on page 2-8.

� “Setting Up QARun To Connect to an ODBC Database” on page 2-9.
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Starting QARun and Connecting to a Microsoft Access Database

If an existing database has not been established, use the following procedure to start 

QARun and connect to a Microsoft Access database:

2. Select the Access MDB option and click Next. The Select Access MDB dialog box 

displays:

3. Type a new database path and name or click the Browse button to select from a list 

of existing databases.

4. Click the Finish button to set the database and continue. The Log On dialog box 

displays:

1. Start QARun:

• Click the Start button and choose Programs>Compuware>QARun from the 

Start menu. 

• Select the QARun icon. The Select Database Connection dialog box displays:

Note

If a QARun database already exists, the Select Database Connection dialog box will not 

display. The Log On dialog box shown in step 4 on page 2-8 displays instead. If 

necessary, you can use the Database button on the Log On dialog box to select from 

existing QARun databases.
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• If this is the first time QARun has been used, type the following information:

User Name: Admin

Password: Admin

• If this is an upgrade, the password may have been changed. Type the correct 

password for the Admin user.

5. Click OK to continue.

You should now be successfully logged on as the QARun administrator. To ensure 

security, you should change the administrator’s password (see “Changing Database 

Maintenance Utility’s Administrator Password” on page 2-15).

Setting Up QARun To Connect to an ODBC Database

This section provides information on setting up QARun to connect to an ODBC database 

server. It provides a basic overview of how QARun communicates with the database 

server and stores QARun data on the server. It provides the following information:

� ODBC database server requirements (Oracle and SQL Server, for example).

� Instructions for running the Database Maintenance utility to create the tables on the 

database server.

� Instructions for starting QARun and connecting to the ODBC database.

Before using QARun to connect to a database server as a client, you must have the 

following items already configured at your site:

Oracle Server Requirements

� You must have an existing database server that runs Oracle 7.3 or 8.

� You must have a database instance set up on the Oracle database server to hold 

QARun and its associated data. Use the following specifics to configure the data-

base instance:

• When the Oracle database instance is defined, you must specify the Storage 

Character Set as 'iso 8859-1 West European'. 

• The NLS_LANGUAGE parameter should be set in the parameter file as:

NLS_LANGUAGE = 'AMERICAN'

� You must have an Oracle userID and password to allow the QARun administrator to 

set up on the Oracle database server.

� You must have access to a valid owner name (also know as a schema) on the Oracle 

database server. This owner name is the userID that will be associated with all the 

QARun tables in the database.

� You must have the QARun workstation set up as an Oracle client. The workstation 

should be able to connect and communicate with the Oracle database server. The 
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following components of the Oracle client must be installed and configured on the 

workstation:

• Microsoft’s MSORCL32.DLL driver provided with the MDAC installation:

The ODBC driver establishes the ODBC data source, which identifies an alias 

to the SQL*Net connect string alias.

• SQL*Net Easy for Windows 95 or SQL*Net Client 2.3.2.1.4 for Windows NT:

The SQL*Net connect string alias establishes the connection to the QARun 

database instance on the Oracle database server.

SQL Server Requirements

� You must have an existing database server that runs SQL Server 6.5.

� You must have a database instance set up on the SQL Server database server to hold 

QARun and its associated data. Use the following specifics to configure the data-

base instance:

• When the SQL Server database instance is defined, you must specify the Stor-

age Character Set 1252 150 (also know as ISO 8859-1). 

� You must have an SQL Server user ID and password to allow the QARun adminis-

trator to set up on the database server. 

� You must have access to a valid owner name (also know as a schema) on the SQL 

Server database server. This owner name is the userID that will be associated with 

all the QARun tables in the database.

� You must have the QARun workstation set up as an SQL Server client. The worksta-

tion should be able to connect and communicate with the SQL Server database 

server. The following components of the SQL Server must be installed and config-

ured on the workstation:

• The SQLSRV32.DLL driver provided with the MDAC installation

You must run QARun’s Database Maintenance utility before attempting to connect 

QARun to the database server (see page 2-11 for instructions).

After QARun is installed on your workstation, use QARun’s Database Maintenance utility 

to populate the QARun database instance on the database server. The QARun workstation 

then uses Data Access Objects (DAO) to connect to a local Microsoft Access “link” file. 

Note

Running the Database Maintenance utility is only necessary if this is a new ODBC (both 

Oracle and SQL Server) server installation. If you are upgrading from a existing QARun 

ODBC database, or if you are converting from a QARun Microsoft Access database to an 

ODBC database, please refer to the QARun User’s Guide for instructions on using the 

Database Maintenance utility.
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The link file resides on the local workstation and is used to map QARun’s tables to the 

database server.

Running the Database Maintenance Utility

The Database Maintenance utility is QARun’s database creation, update, repair, and 

conversion utility. During installation, this utility is also used to create the QARun tables 

on the different types of supported ODBC database servers and to establish secure logon 

access to the database server by generating a schema file.

1. Ensure that QARun is closed and all users are logged off the system before using the 

Database Maintenance utility program.

Caution

Using the Database Maintenance utility to create a new ODBC database will overwrite 

any QARun information already contained in the specified database instance. You 

should only use the following procedure to create a new QARun ODBC database.

If you are upgrading your QARun ODBC database, or if you are converting from a 

Microsoft Access database to an ODBC database, please refer to the QARun User’s 

Guide for instructions on using the Database Maintenance utility in this manner.

Hint

Before closing QARun, you can choose Users from the Help menu to display the Current 

Users dialog box. This dialog box displays a list of all active QARun users currently 

logged on to the QARun database. Ensure that the users are logged off and close 

QARun.

2. Start the Database Maintenance utility:

• Click the Start button and select Programs>Compuware>QARun from the 

Start menu. 

Choose the Database Maintenance Utility icon. The Database Maintenance utility 

main window displays:
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3. From the File menu, choose New Database>Database Type. The applicable Data 

Source Connection dialog box displays:

4. Type the name of an existing ODBC data source or click the Browse button and 

select a data source name from the Select ODBC Data Source dialog box. 

5. Type the owner name, user ID, and password for the QARun database instance on 

the database server.

This user ID and password will be used to attempt a connection to the QARun data-

base instance on the database server for the owner specified. If this succeeds, this 

user ID, password, and owner schema will eventually be encrypted and saved to a 

schema file with a .sch extension.

6. Click the Create button.

If the user ID and password are accepted by the database server, the Data Source 

Creation Status dialog box appears and displays the progress of the database cre-

ation.

After the QARun database is created on the database server, you are prompted for a 

location to save the schema file.
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7. Click Yes to create the encrypted schema file. The Schema File Generation dialog 

box displays:

8. Type a name and location for the schema file in the Schema File field or click the 

Browse button to select an existing schema file. 

9. Type the name of an existing ODBC data source or click the Browse button and 

select a data source name from the Select ODBC Data Source dialog box. 

10. Type the owner name, user ID, and password for the QARun database instance on 

the database server.

11. Click OK. The schema file is saved and the Database Maintenance utility begins 

populating the QARun database instance with the necessary QARun tables.

Starting QARun and Connecting to ODBC Databases

Use the following procedure to start QARun and connect to a database server after 

successfully running the Database Maintenance utility:

1. Start QARun:

• Click the Start button and select Programs>Compuware>QARun from the 

Start menu. 

• Choose the QARun icon.

2. If this is the first time you’ve started QARun, the Select Database Connection dialog 

box displays.

If a QARun database already exists, the Select Database Connection dialog box will 

not display. The Log On dialog box shown in step 8 on page 2-14 displays instead. If 

necessary, you can use the Database button on the Log On dialog box to select from 

existing QARun databases.
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3. Click the Via ODBC option and click Next. The Select ODBC Data Source dialog 

box displays:

4. Use the New button (to create a new link file) or the Browse button (to select an 

existing link file) to select a path and name for the link file in the QACenter Link 

Database field.

The link file (.qld) is a Microsoft Access database that resides on the local machine 

and maps QARun’s tables to the database server. If QARun detects a change in the 

version of the database schema (version), the link file will automatically trigger an 

update to QARun’s tables.

5. Enter the name of the ODBC data source alias in the ODBC Data Source field or 

click the Browse button to view a list of existing ODBC data sources.

6. Enter the path and name of the schema file that was generated by QARun’s 

Database Maintenance utility in the Schema File field (see “Running the Database 

Maintenance Utility” on page 2-11 for more information).

7. Click Finish to continue. 

The first time you start QARun, or if you’ve previously selected a database and 

QARun detects a change in the version of the database schema, the link file will 

automatically trigger an update to QARun’s tables. QARun will update each internal 

table, and a status indicator will display.

8. After the tables are updated, QARun’s Log On dialog box displays:
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• If this is the first time QARun has been used, enter the following information:

User Name: Admin

Password: Admin

• If this is an upgrade, the password may have been changed. Enter the correct 

password for the Admin user.

9. Click OK to continue. 

You should now be successfully logged on as the QARun administrator. To ensure 

security, you should change the administrator’s password (see the following section on 

“Changing Database Maintenance Utility’s Administrator Password” on page 2-15).

Changing Database Maintenance Utility’s Administrator Password

When you install QARun for the first time, the a Database Maintenance utility contains a 

single user (Admin). The default password for the Admin user is “Admin”. You should 

change the Admin user’s password to prevent unauthorized access to this ID in the future. 

To change the administration password:

2. From the File menu, select Open Database> Database Type. The applicable Data 

Source Connection dialog box displays:

1. Start the Database Maintenance utility:

• Click the Start button and choose Programs>Compuware>QARun.

• Choose the Database Maintenance Utility icon. The Database Maintenance 

utility main window displays:
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3. Type the name of the database or click Browse and navigate to the file.

If necessary for ODBC databases, enter the owner name, user ID, and password and 

click Open to log on to the ODBC database.

4. With the database open, choose Tools>User Administration. The Log On dialog 

box displays prompting you to enter your user name and password to log on to the 

QARun database.

• If this is the first time QARun has been used, enter the following information:

User Name: Admin

Password: Admin

• If this is an upgrade, the password may have been changed. Enter the correct 

password for the Admin user.

You should now be successfully logged on as the QARun administrator. To ensure 

security, you should change the administrator’s password.

5. Click OK to continue. The Select User dialog box displays:

6. Select Admin from the list of users and click the Edit button. The Edit User dialog 

box displays:
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7. Type the new password in the New Password Field. Type it again in the Verify 

Password field. Click OK.

If you are setting up a network installation, you should add user IDs to the database for 

each end user. If you are using a stand-alone PC, you should add your own user ID. Refer 

to the section on adding users in the QARun User’s Guide for instructions on adding end 

users.

For information on using QARun and the Database Maintenance utility, refer to the 

QARun User’s Guide. You can access the QARun User’s Guide from the documentation 

bookshelf. To do so, click the taskbar’s Start button and choose 

Programs>Compuware>QARun>QARun Books>QARun Bookshelf.
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Chapter 3.   Installing QADirector 4.3

You have three installation options for QADirector: a full installation, a client installation, 

or a remote installation. Descriptions and procedures for each type of installation are 

provided in this chapter. This chapter includes the following sections:

� System Requirements — The hardware and software requirements for installing 

QADirector.

� Minimum Requirements for Integrated Tools — Version requirements for inte-

grated Compuware tools.

� Choosing the Installation Type — How to choose the appropriate type of installa-

tion for your working environment.

� Performing a Full Installation — How to complete a full installation of all QADi-

rector programs and files on a local or network drive.

� Performing a Client Installation — How to perform a client installation, which 

stores specific files on a local drive while sharing other files on a network.

� Performing a Remote Installation — How to complete a remote installation, 

which allows you to run tests on a remote machine.

System Requirements

� Pentium 120-MHz processor or above (166 MHz or above recommended)

� 32 MB RAM (64 MB recommended)

� CD-ROM drive

� VGA monitor and adapter

� Server installations: Microsoft Windows NT 4.0 with minimum 65 MB free disk 

space

� Client installations: Microsoft Windows NT 4.0, Windows 95, or Windows 98 

with minimum 41 MB free disk space
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3270 Emulator

If you intend to run QAHiperstation scripts or MVS batch jobs, a 16-bit or 32-bit 

Windows 3270 terminal emulation software package is also required. For detailed infor-

mation on the supported 3270 emulators and minimum version requirements, please read 

the QA 3270 Emulator Server Readme.txt file. The QA 3270 Emulator Server can be 

installed from the QACenter CD.

Minimum Requirements for Integrated Tools

If you intend to use QADirector with any of the following Compuware tools, please note 

the minimum version requirements:

� QARun Release 4.3.2 or above (Release 4.4 or above required to view run logs)

� QAHiperstation Release 5.3.1 or above (Release 5.4 or above required to run MVS 

batch jobs or view compare logs with QAHiperstation+)

� QAHiperstation+ Release 1.0.1 or above

� QA3270 Emulator Server Release 2.4.2 or above required to run QAHiperstation or 

MVS batch jobs

� File-AID/CS Convert Release 2.00.05 or above

� File-AID/CS Compare Release 1.01.00 or above

� TrackRecord Release 5.0 or above

� QATrackRecord Release 4.0 or above

� BoundsChecker Release 5.0 or above

� TrueCoverage Release 6.0 or above

� TrueTime Release 1.22 or above

Choosing the Installation Type

You have three installation options for QADirector: a full installation, a client installation, 

or a remote installation. The type of installation you choose depends on your working 

environment.

Stand-alone Environment: Perform One Full Installation

If only one person will use QADirector, perform a full installation of QADirector on a 

stand-alone Windows NT 4.0 workstation. See “Performing a Full Installation” on page 

3-4.
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Team Environment: Perform Full Installation on Server and Client Installations 

on Workstations

If you work in a team environment where several people will use QADirector and share 

test data, the most logical choice will be to perform a full installation of QADirector on a 

shared server machine accessible to all the workstations. In most cases, this is the 

machine where the test management server runs and where the test suite data is stored. 

See “Supported Client/Server Configurations” on page 3-3. After you complete a full 

installation on the shared network drive, you need to perform a client installation on each 

Windows 95, Windows 98, or Windows NT 4.0 workstation where QADirector will be 

run. On each workstation, you must map a permanent drive to the shared network drive 

where the full installation of QADirector resides. Each client workstation runs a test 

execution server so that scripts can be executed on the workstation. See “Performing a 

Full Installation” on page 3-4 and “Performing a Client Installation” on page 3-7.

Supported Client/Server Configurations

Recommended Configuration

� Full installation on a Windows NT 4.0 Server machine. The Test Management 

Server runs on this machine, either as an NT service or as a console application.

� Test suites stored on the NT 4.0 Server machine.

� Client installations on Windows NT 4.0 machines.

� TCP/IP protocol loaded on all machines.

� Access to a DNS server to resolve the address to all workstations.

Alternative Configuration 1

� Full installation on a Windows NT 4.0 Server or Workstation machine. The Test 

Management Server runs on this machine, either as an NT service or as a con-

sole application. You may encounter a 10 concurrent-user limitation on a Win-

dows NT Workstation machine.

� Test suites stored on the NT 4.0 Server or Workstation machine. 

� Client installations on Windows 95, Windows NT 4.0, or Windows 98 machines.

� TCP/IP protocol loaded on all machines.

� Access to a DNS server to resolve the address to all workstations.

Alternative Configuration 2

� Full installation on a Novell 5.x machine. The Test Management Server runs on a 

Windows NT 4.0 machine, either as an NT service or as a console application.

� Test suites stored on a Novell 5.x network drive.
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Remote Installation

In rare instances, you may want to perform a remote installation on a machine that does 

not have file sharing but on which you want to execute tests. See “Performing a Remote 

Installation” on page 3-9.

Performing a Full Installation

A full installation copies all QADirector programs and associated files to the specified 

drive. Perform a full installation of QADirector if you want to:

� Install QADirector locally on a stand-alone Windows NT 4.0 workstation so that 

one person can use QADirector without logging on to a network.

� Install QADirector on a shared Windows NT 4.0 workstation or server, so that mul-

tiple users can run it from their local workstations. In this case, after you perform 

the full installation, you must also perform a client installation at each workstation. 

Refer to “Performing a Client Installation” on page 3-7.

To perform a full installation, follow these steps:

� Client installations on Windows 95, Windows NT 4.0, or Windows 98 machines.

� TCP/IP protocol loaded on all machines.

� Access to a DNS server to resolve the address to all workstations.

Alternative Configuration 3

� Full installation on Windows NT 4.0 machine. The Test Management Server runs 

on this machine, either as an NT service or as a console application.

� Test suites stored on a Novell 5.x network drive.

� Client installations on Windows 95, Windows NT 4.0, or Windows 98 machines.

� TCP/IP protocol loaded on all machines.

� Access to a DNS server to resolve the address to all workstations.

Alternative Configuration 2

Note

Before you install QADirector, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 9, “Installing a Permanent License” for 

instructions on installing a license.
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1. Log on to the Windows NT machine as a user with administrator privileges for that 

machine.

2. Insert the QACenter CD into the CD-ROM drive. The QACenter setup should 

automatically start. If it does not, run setup.exe from the CD root directory.

3. Click Install QACenter Products.

4. Click Install QADirector.

5. Click Install QADirector (32-bit).

6. Read the QADirector Welcome screen and click Next.

7. Read the software license agreement and click Yes if you accept.

8. On the User Information dialog box, type your name and company. Click Next.

9. On the Choose Destination Location dialog box, select the directory where you 

want to install QADirector. Click Next.

10. On the Setup Type dialog box, select Full. Click Next.

11. On the Select Optional Components dialog box, select the check box next to each 

item you want to install:

• BoundsChecker

• TrueCoverage

• TrueTime

• JRE (Java Runtime Environment)

Select BoundsChecker, TrueCoverage, or TrueTime to install a runtime version of 

either product. (Before installing the runtime version of a product, verify that at 

least one person on your team has a full version of the product so the test application 

can be instrumented.) Select JRE if you intend to use manual tests in QADirector. If 

a component is already installed on your computer, the item will not appear on this 

dialog box. The dialog box itself will not appear if all the items are already installed. 

Make your selections and click Next.

12. The Install Test Manager Server dialog box displays these options:

• Install as a console application

• Install as a service (start service automatically on reboot)

The test management server maintains QADirector data about jobs and test suites, 

provides services to clients, and controls job execution. You cannot start QADirec-

tor unless the test management server is running, either on the same workstation or 

on a shared network machine. You can choose to set up the test management server 

as a console application or as a Windows NT service. You may want to set up the 

test management server as a service if, for example, you are installing it on a 
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machine where users are periodically logging on and off, and you want to make sure 

the test management server is always running.

Select whether to install the test management server as a console application or as a 

service. Click Next.

13. The Install SQM Agent dialog box displays these options:

• Do not install the SQM Agent on this system

• Install as a console application

The SQM Agent enables data synchronizing between the test suite directories and 

the QADirector database. This means that if you synchronize data for a test suite, 

QADirector automatically saves the test suite data in both the test suite directory and 

in the QADirector database. Note that this cannot be used as a method for sharing 

test suites among a team. That is, QADirector does not read suite data from the data-

base. Instead, the suite data in the database may be helpful if, for example, you want 

to use a report writer to extract information from the database to create a custom 

report. If you do not plan to use the data synchronization option, do not install the 

SQM Agent.

Select whether or not to install the SQM Agent and click Next.

14. Select the program folder to which you want to add the QADirector program icons. 

The default is the Compuware>QADirector program folder. Click Next.

15. Review the settings on the Start Copying Files dialog box and click Next to begin 

installing the program files.

16. If you chose to install the Java Runtime Environment (JRE) in step 11, the program 

starts a self-extracting executable to install it.

17. When the installation is complete, restart your computer.

Where To Go Next

� If you installed QADirector on a network and are ready to establish workstation cli-

ents, proceed to “Performing a Client Installation” on page 3-7.

� If you installed QADirector on a stand-alone workstation, and you intend to use 

QAHiperstation with QADirector, you need to install the QA 3270 Emulator Server 

on this workstation (if you have not already done so). The QA 3270 Emulator 

Server manages the communications between your 3270 mainframe emulator and 

QADirector when accessing and executing QAHiperstation scripts on the main-

frame. To install the QA 3270 Emulator Server, insert the QACenter CD into the 

CD-ROM drive. Click Install QACenter Products. Click Install QADirector. 

Click Install QA 3270 Emulator Server.

� If Adobe Acrobat Reader is not installed on your workstation, return to the initial 

QACenter setup screen and click Install Adobe Acrobat Reader to launch Adobe’s 
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installation program. You must have Adobe Acrobat Reader installed in order to 

view QADirector’s books online in PDF format.

� If you are ready to begin using QADirector, refer to the “Administrator Tasks” chap-

ter in the QADirector Windows User’s Guide for information about setting up user 

IDs and the QADirector database.

Performing a Client Installation

A client installation of QADirector copies specific application files to your local drive and 

shares other working files and executables with the network installation. Consequently, a 

client installation requires significantly less local disk space than a full installation. You 

should perform a client installation if you want to:

� Share test suite data with a team

� Centrally manage QADirector

You must complete a client installation on each workstation that will run the shared 

QADirector installation on the network. Client installations can be performed on 

Windows 95, Windows 98, and Windows NT 4.0 workstations.

Prerequisites:

� Complete a full installation of QADirector on a shared Windows NT 4.0 machine 

accessible by the client machines. Refer to “Performing a Full Installation” on page 

3-4 for details.

� On each workstation, map a permanent drive to the drive where the full installation 

of QADirector resides. Make sure the client machines have read/write access to this 

directory.

� Before you install QADirector, you must have a valid license installed. See Chapter 

1, “Installing a Temporary License” or Chapter 9, “Installing a Permanent License” 

for instructions on installing a license.

Follow these steps to complete the client installation:

1. Insert the QACenter CD into the CD-ROM drive of the client machine. The 

QACenter setup should automatically start. If it does not, run setup.exe from the 

CD root directory.

2. Click Install QACenter Products.

3. Click Install QADirector.

4. Click Install QADirector (32-bit).

5. Read the QADirector Welcome screen and click Next.

6. Read the software license agreement and click Yes if you accept.
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7. On the User Information dialog box, type your name and company. Click Next.

8. On the Choose Destination Location dialog box, select the directory where you 

want to install QADirector. Click Next.

9.  On the Setup Type dialog box, select Client. Click Next. 

10. On the Select Optional Components dialog box, select the check box next to each 

item you want to install:

• BoundsChecker

• TrueCoverage

• TrueTime

• JRE (Java Runtime Environment)

Select BoundsChecker, TrueCoverage, or TrueTime to install a runtime version of 

either product. (Before installing the runtime version of a product, verify that at 

least one person on your team has a full version of the product so the test application 

can be instrumented.) Select JRE if you intend to use manual tests in QADirector. If 

a component is already installed on your computer, the item will not appear on this 

dialog box. The dialog box itself will not appear if all the items are already installed. 

Make your selections and click Next. The Full Installation Location dialog box 

appears:

11. Enter the location where the full installation of QADirector resides. The client 

machine must have read/write access to this directory. Click Next.

12. Select the program folder to which you want to add the QADirector program icons. 

The default is the Compuware>QADirector program folder. Click Next.

13. Review the settings on the Start Copying Files dialog box and click Next to begin 

installing the program files.
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14. If you chose to install the Java Runtime Environment (JRE) in step 10, the program 

starts a self-extracting executable to install it.

15. When the installation is complete, restart your computer.

Where To Go Next

� If you intend to use QAHiperstation with QADirector, you need to install the QA 

3270 Emulator Server on this workstation (if you have not already done so). The 

QA 3270 Emulator Server manages the communications between your 3270 main-

frame emulator and QADirector when accessing and executing QAHiperstation 

scripts on the mainframe. To install the QA 3270 Emulator Server, insert the 

QACenter CD into the CD-ROM drive. Click Install QACenter Products. Click 

Install QADirector. Click Install QA 3270 Emulator Server.

� If Adobe Acrobat Reader is not installed on your workstation, return to the initial 

QACenter setup screen and click Install Adobe Acrobat Reader to launch Adobe’s 

installation program. You must have Adobe Acrobat Reader installed in order to 

view QADirector’s books online in PDF format.

� If you are ready to begin using QADirector, refer to the “Administrator Tasks” chap-

ter in the QADirector Windows User’s Guide for information about setting up user 

IDs and the QADirector database.

Performing a Remote Installation

Remote machines are computers that do not have file sharing and thus cannot share the 

data in QADirector test suites. This means that you cannot create or update test suite data 

on the remote machine. You can, however, execute tests on the remote machine if you 

perform a remote installation on the machine. This process installs the test execution 

server and other files needed to run tests on the remote machine. You can perform remote 

installations on machines running Windows 95, Windows 98, and Windows NT 4.0.

1. Insert the QACenter CD into the CD-ROM drive of the remote machine. The 

QACenter setup should automatically start. If it does not, run setup.exe from the 

CD root directory.

2. Click Install QACenter Products.

3. Click Install QADirector.

4. Click Install QADirector (32-bit).

5. Read the QADirector Welcome screen and click Next.

6. Read the software license agreement and click Yes if you accept.

7. On the User Information dialog box, type your name and company. Click Next.
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8. On the Choose Destination Location dialog box, select the directory where you 

want to install QADirector. Click Next.

9. On the Select Optional Components dialog box, select the check box next to each 

item you want to install:

• BoundsChecker

• TrueCoverage

• TrueTime

• JRE (Java Runtime Environment)

Select BoundsChecker, TrueCoverage, or TrueTime to install a runtime version of 

either product. (Before installing the runtime version of a product, verify that at 

least one person on your team has a full version of the product so the test application 

can be instrumented.) Select JRE if you intend to use manual tests in QADirector. If 

a component is already installed on your computer, the item will not appear on this 

dialog box. The dialog box itself will not appear if all the items are already installed. 

Make your selections and click Next.

10. On the Setup Type dialog box, select Remote. Click Next. The Full Installation 

Location dialog box appears:

11. Enter the location where the full installation of QADirector resides. The remote 

machine must have read/write access to this directory. Click Next. The Remote 

Installation Location dialog box appears:
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12. Enter the host name of the machine where the full installation of QADirector 

resides. Click Next.

13. Select the program folder to which you want to add the QADirector program icons. 

The default is the Compuware>QADirector program folder. Click Next.

14. Review the settings on the Start Copying Files dialog box and click Next to begin 

installing the program files.

15. If you chose to install the Java Runtime Environment (JRE) in step 9, the program 

starts a self-extracting executable to install it.

16. When the installation is complete, restart your computer.

Where To Go Next

If you are ready to begin using QADirector, refer to the “Administrator Tasks” chapter in 

the QADirector Windows User’s Guide for information about setting up user IDs and the 

QADirector database.
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Chapter 4.   Installing WebCheck

This chapter explains how to install WebCheck. It includes the following sections:

� System Requirements — The hardware and software requirements for installing 

and running WebCheck.

� Installing WebCheck — How to install WebCheck.

� Starting WebCheck and Connecting to a Database — Instructions for starting 

WebCheck for the first time and connecting to a database.

System Requirements

To use WebCheck, you must have the following:

� IBM or compatible PC with Pentium class processor

� Windows 95, 98, or NT 4.0 with service pack 4 or greater

� 32 bit Internet connection

� 32 MB RAM (64MB recommended)

� 5 MB free hard disk space

� Internet Explorer 4.01 with service pack 2 or greater.

WebCheck can scan any Web server and is not platform dependent in its scans.

Installing WebCheck

1. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products.

2. Click Install WebCheck. The Setup program starts automatically.

Note

Internet Explorer does not need to be your browser of choice; however, it is needed when 

using the Browse feature found in the right pane.
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3. Read the Welcome dialog box and click Next.

4. Read the software license agreement and click Yes if you accept.

5. On the User Information dialog box, enter your name and company name and click 

Next.

6. The Choose Destination Location dialog box displays the default directory where 

the WebCheck files will be installed. To install to a different location, click Browse 

and select another directory. Click Next.

7. By default, the setup program will add the WebCheck program icons to the 

Compuware>WebCheck program folder. You can choose a different folder. Click 

Next.

8. On the Start Copying Files dialog box, verify the installation settings and click 

Next.

9. When installation is complete, the Setup Complete dialog box appears. If it is 

necessary to reboot your machine at this time, the setup program will prompt you to 

do so. Click Finish.

Where To Go Next

� If you are ready to begin using WebCheck, proceed to “Starting WebCheck and 

Connecting to a Database” on page 4-2.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD’s Products Installation dialog box and click the Get Acrobat button 

to launch Adobe’s installation program. You must have Adobe Acrobat Reader 

installed in order to view WebCheck’s books online in PDF format.

Starting WebCheck and Connecting to a Database

WebCheck’s architecture is based on a test asset repository, or database. This multi-user 

repository offers centralized control of users and system access rights. This section 

provides details on connecting to the appropriate database and changing the Adminis-

tration password.

Note

WebCheck requires that DCOM (Distributed Component Object Model) and MDAC 

(Microsoft’s Data Access Components) be installed on your computer. If the WebCheck 

Setup does not detect DCOM (Windows 95 only) and MDAC on your workstation, you will 

be prompted to install them. After installing DCOM or MDAC, the setup program will 

prompt you to reboot your machine. After you reboot, WebCheck Setup will restart 

automatically.
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Before you use WebCheck, you need to determine the type of database you will be using. 

Use the following procedures to connect to the appropriate database type:

� “Starting WebCheck and Connecting to a Microsoft Access Database” on page 4-3.

� “Setting Up WebCheck To Connect to an ODBC Database” on page 4-4.

Starting WebCheck and Connecting to a Microsoft Access Database

If an existing database has not been established, use the following procedure to start 

WebCheck and connect to a Microsoft Access database:

2. Select the Access MDB option and click Next. The Select Access MDB dialog box 

displays:

3. Type a new database path and name or click the Browse button to select from a list 

of existing databases.

4. Click the Finish button to set the database and continue. The Log On dialog box 

displays:

Note

If you have QARun version 4.7 or greater, you can connect to the QARun database.

1. Start WebCheck:

• Click the Start button and choose Programs>Compuware>WebCheck.

• Select the WebCheck icon. The Select Database Connection dialog box dis-

plays:

Note

If a WebCheck database already exists, the Select Database Connection dialog box will 

not display. The Log On dialog box shown in step 4 on page 4-3 displays instead. If 

necessary, you can use the Database button on the Log On dialog box to select from 

existing WebCheck databases.
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• If this is the first time WebCheck has been used, type the following informa-

tion:

User Name: Admin

Password: Admin

• If this is an upgrade, the password may have been changed. Type the correct 

password for the Admin user.

5. Click OK to continue.

You should now be successfully logged on as the WebCheck administrator. To ensure 

security, you should change the administrator’s password (see “Changing the WebCheck 

Administrator Password” on page 4-10).

Setting Up WebCheck To Connect to an ODBC Database

This section explians how to set up WebCheck to connect to an ODBC database server. 

It provides an overview of how WebCheck communicates with the database server and 

stores WebCheck data on the server. It includes the following information:

� ODBC database server requirements (Oracle and SQL Server, for example)

� Instructions for running the Database Maintenance utility to create the tables on the 

database server

� Instructions for starting WebCheck and connecting to the ODBC database.

Before using WebCheck to connect to a database server as a client, you must have the 

following items already configured at your site:

Oracle Server Requirements

� You must have an existing database server that runs Oracle 7.3 or 8.

� You must have a database instance set up on the Oracle database server to hold 

WebCheck and its associated data. Use the following specifics to configure the data-

base instance:

• When the Oracle database instance is defined, you must specify the Storage 

Character Set as 'iso 8859-1 West European'. 

• The NLS_LANGUAGE parameter should be set in the parameter file as:

NLS_LANGUAGE = 'AMERICAN'
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� You must have an Oracle user ID and password to allow the WebCheck administra-

tor to set up on the Oracle database server.

� You must have access to a valid owner name (also know as a schema) on the Oracle 

database server. This owner name is the user ID that will be associated with all the 

WebCheck tables in the database.

� You must have the WebCheck workstation set up as an Oracle client. The worksta-

tion should be able to connect and communicate with the Oracle database server. 

The following components of the Oracle client must be installed and configured on 

the workstation:

• Microsoft’s MSORCL32.DLL driver provided with the MDAC installation:

The ODBC driver establishes the ODBC data source, which identifies an alias 

to the SQL*Net connect string alias.

• SQL*Net Easy for Windows 95 or SQL*Net Client 2.3.2.1.4 for Windows NT:

The SQL*Net connect string alias establishes the connection to the WebCheck 

database instance on the Oracle database server.

SQL Server Requirements

� You must have an existing database server that runs SQL Server 6.5.

� You must have a database instance set up on the SQL Server database server to hold 

WebCheck and its associated data. Use the following specifics to configure the data-

base instance:

• When the SQL Server database instance is defined, you must specify the Stor-

age Character Set 1252 150 (also know as ISO 8859-1). 

� You must have an SQL Server user ID and password to allow the WebCheck admin-

istrator to set up on the database server. 

� You must have access to a valid owner name (also know as a schema) on the SQL 

Server database server. This owner name is the user ID that will be associated with 

all the WebCheck tables in the database.

� You must have the WebCheck workstation set up as an SQL Server client. The 

workstation should be able to connect and communicate with the SQL Server data-

base server. The following components of the SQL Server must be installed and 

configured on the workstation:

• The SQLSRV32.DLL driver provided with the MDAC installation
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You must run WebCheck’s Database Maintenance utility before attempting to connect 

WebCheck to the database server (see page 4-6 for instructions).

After WebCheck is installed on your workstation, use WebCheck’s Database Mainte-

nance utility to populate the WebCheck database instance on the database server. The 

WebCheck workstation then uses Data Access Objects (DAO) to connect to a local 

Microsoft Access “link” file. The link file resides on the local workstation and is used to 

map WebCheck’s tables to the database server.

Running the Database Maintenance utility

The Database Maintenance utility is WebCheck’s database creation, update, repair, and 

conversion utility. During installation, this utility is also used to create the WebCheck 

tables on the different types of supported ODBC database servers and to establish secure 

logon access to the database server by generating a schema file.

1. Ensure that WebCheck is closed and all users are logged off  before using the Data-

base Maintenance utility program.

Note

Running the Database Maintenance utility is only necessary if this is a new ODBC (both 

Oracle and SQL Server) server installation. If you are upgrading from a existing 

WebCheck ODBC database, or if you are converting from a WebCheck Microsoft Access 

database to an ODBC database, please refer to the WebCheck User’s Guide for 

instructions on using the Database Maintenance utility.

Caution

Using the Database Maintenance utility to create a new ODBC database will overwrite 

any WebCheck information already contained in the specified database instance. You 

should only use the following procedure to create a new WebCheck ODBC 

database.

If you are upgrading your WebCheck ODBC database, or if you are converting from a 

Microsoft Access database to an ODBC database, please refer to the WebCheck User’s 

Guide for instructions on using the Database Maintenance utility in this manner.
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2. From the File menu, choose New Database>Database Type. The applicable Data 

Source Connection dialog box displays:

3. Type the name of an existing ODBC data source or click the Browse button and 

select a data source name from the Select ODBC Data Source dialog box. 

4. Type the owner name, user ID, and password for the WebCheck database instance 

on the database server.

This user ID and password will be used to attempt a connection to the WebCheck 

database instance on the database server for the owner specified. If this succeeds, 

this user ID, password, and owner schema will eventually be encrypted and saved to 

a schema file with a .sch extension.

5. Click the Create button.

If the user ID and password are accepted by the database server, the Data Source 

Creation Status dialog box appears and displays the progress of the database cre-

ation.

After the WebCheck database is created on the database server, you are prompted 

for a location to save the schema file.
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6. Click Yes to create the encrypted schema file. The Schema File Generation dialog 

box displays:

7. Type a name and location for the schema file in the Schema File field or click the 

Browse button to select an existing schema file. 

8. Type the name of an existing ODBC data source or click the Browse button and 

select a data source name from the Select ODBC Data Source dialog box. 

9. Type the owner name, user ID, and password for the WebCheck database instance 

on the database server.

10. Click OK. The schema file is saved and the Database Maintenance utility begins 

populating the WebCheck database instance with the necessary WebCheck tables.

Starting WebCheck and Connecting to ODBC Databases

After you run the Database Maintenance utility, use the following procedure to start 

WebCheck and connect to a database server:

1. Start WebCheck:

•  From the Start menu, select Programs>Compuware>WebCheck.

• Choose the WebCheck icon.

2. If this is the first time you’ve started WebCheck, the Select Database Connection 

dialog box displays.

If a WebCheck database already exists, the Select Database Connection dialog box 

will not display. The Log On dialog box shown in step 8 on page 4-9 displays 

instead. If necessary, you can use the Database button on the Log On dialog box to 

select from existing WebCheck databases.
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3. Click the Via ODBC option and click Next. The Select ODBC Data Source dialog 

box displays:

4. Use the New button (to create a new link file) or the Browse button (to select an 

existing link file) to select a path and name for the link file in the QACenter Link 

Database field.

The link file (.qld) is a Microsoft Access database that resides on the local machine 

and maps WebCheck’s tables to the database server. If WebCheck detects a change 

in the version of the database schema (version), the link file will automatically trig-

ger an update to WebCheck’s tables.

5. Enter the name of the ODBC data source alias in the ODBC Data Source field or 

click the Browse button to view a list of existing ODBC data sources.

6. Enter the path and name of the schema file that was generated by WebCheck’s 

Database Maintenance utility in the Schema File field (see “Running the Database 

Maintenance utility” on page 4-6 for more information).

7. Click Finish to continue. 

The first time you start WebCheck, or if you’ve previously selected a database and 

WebCheck detects a change in the version of the database schema, the link file will 

automatically trigger an update to WebCheck’s tables. WebCheck will update each 

internal table, and a status indicator will display.

8. After the tables are updated, WebCheck’s Log On dialog box displays:
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• If this is the first time WebCheck has been used, enter the following informa-

tion:

User Name: Admin

Password: Admin

• If this is an upgrade, the password may have been changed. Enter the correct 

password for the Admin user.

9. Click OK to continue. 

You should now be successfully logged on as the WebCheck administrator. To ensure 

security, you should change the administrator’s password (see the following section on 

“Changing the WebCheck Administrator Password” on page 4-10).

Changing the WebCheck Administrator Password

When you install WebCheck for the first time, a database containing a single user 

(Admin) is created. The default password for the Admin user is “Admin”. You should 

change the Admin user’s password to prevent unauthorized access to this ID in the future. 

To change the administration password:

2. From the File menu, select Open Database> Database Type. The applicable Data 

Source Connection dialog box displays:

1. Start the Database Maintenance utility:

• Click the Start button and select Programs>Compuware>WebCheck.

• Choose the Database Maintenance utility icon. The Database Maintenance 

utility main window displays:
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3. Type the name of the database or click Browse and navigate to the file.

If necessary for ODBC databases, enter the owner name, user ID, and password and 

click Open to log on to the ODBC database.

4. With the database open, choose Tools>User Administration. The Log On dialog 

box displays prompting you to enter your user name and password to log on to the 

WebCheck database.

• If this is the first time WebCheck has been used, enter the following informa-

tion:

User Name: Admin

Password: Admin

You should now be successfully logged on as the WebCheck administrator. To 

ensure security, you should change the administrator’s password.

5. Click OK to continue. The Select User dialog box displays:

6. Select Admin from the list of users and click the Edit button. The Edit User dialog 

box displays:
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7. Type the new password in the New Password Field. Type it again in the Verify 

Password field. Click OK.

For information on using WebCheck and the Database Maintenance utility, refer to the 

WebCheck User’s Guide. You can access the WebCheck User’s Guide from the documen-

tation bookshelf. To do so, click the taskbar’s Start button and choose 

Programs>Compuware>WebCheck>Documentation Bookshelf.
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Chapter 5.   Installing QALoad

A full QALoad installation provides all the files necessary to capture, convert, modify, 

and play back test scripts. In addition to a full installation, you may choose to perform a 

component-based installation, in which you choose to install only specific QALoad 

components. For example, you may wish to install the QALoad Player on additional 

Windows or UNIX workstations. In that case, you could choose to only install the appro-

priate Player on those workstations.

This chapter includes the following sections: 

� System Requirements — Hardware and software requirements for a full installa-

tion, as well as for each QALoad component.

� QALoad Installation — Instructions for installing QALoad.

� UNIX Player Installation — Instructions for installing the QALoad UNIX Player.

Note

Before you install QALoad, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 9, “Installing a Permanent License” for 

instructions on installing a license.
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System Requirements

This section describes the general requirements for the system running a complete instal-

lation of QALoad, as well as requirements for each individual QALoad component that 

may be installed separately. 

Complete Installation Requirements

� 133-MHz Pentium PC or above

� 16 MB RAM or more, plus an additional 1 MB per virtual user

� 40 MB available hard-drive space or more

� TCP/IP communications stack with a winsock.dll

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT 4, SP3 or 

later (SP4 recommended). Note that QALoad does not support testing DCOM-based 

applications in Windows 98.

� 3 MB virtual memory per virtual user

� To compile scripts using Microsoft Visual C++ 5.0, you must have Service Pack 3 

installed.

Requirements by Component

The following sections detail the system requirements necessary for installing each 

individual QALoad component.

QALoad Script Development Workbench

Capturing 32-bit applications

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT 4, SP3 or 

later (SP4 recommended)

� 32 MB RAM or more

� 100 MB minimum available hard drive space

Note

QALoad’s Windows-based components are not supported on a Windows 95A operating 

system. See the specific requirements listed below for more information.
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Capturing 16-bit applications

� 486 33-MHz PC or above

� 8 MB RAM or more

� 10 MB available hard-drive space or more

� TCP/IP communications stack with a winsock.dll

� Windows 3.x

QALoad Conductor Requirements

� 233-MHz Pentium PC or higher

� 64 MB RAM or more

� 100 MB minimum available hard drive space

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT 4, SP3 or 

later (SP4 recommended)

� TCP/IP communications.

QALoad Windows Player Requirements

� 233-MHz Pentium PC or above

� 100 MB minimum available hard drive space

� 64 MB RAM or more

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT 4, SP3 or 

later (SP4 recommended)

� TCP/IP communications

� Appropriate client application environment.

In addition, the Windows system running the QALoad Windows Player may need to meet 

specific requirements to support the middleware you will be testing. For middleware-

specific requirements, see the following sections:

� “Windows Player Requirements for Oracle 7.x” on page 5-3

� “Windows Player Requirements for Oracle Net8” on page 5-4

� “Windows Player Requirements for Sybase” on page 5-5

� “Windows Player Requirements for SQL Server” on page 5-5

� “Windows Player Requirements for ODBC” on page 5-5

� “Windows Player Requirements for TUXEDO” on page 5-5

� “Windows Player Requirements for UNIFACE” on page 5-6

Windows Player Requirements for Oracle 7.x

The system running the Windows Player requires the following:

� Oracle 7.x or above client installation for playback

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT 4, SP3 or 

later (SP4 recommended)
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� Oracle’s SQL*NET for Windows NT. This product is supplied by Oracle and should 

be installed and tested prior to running QALoad.

� SQL*NET communications between the client application and the database. Typi-

cal SQL*NET development environments include products such as PowerBuilder, 

SQLWindows, Developer 2000, and ODBC-based systems. Applications developed 

in these environments allow for complete client-oriented capture.

� Microsoft’s Visual C++ Version 5.0 or 6.0. Note that you do not need to install any 

of the MFC components.

� Oracle OCI development kit for Windows NT. This is distributed with Oracle’s 

PRO*C pre-compiler kit or with Oracle’s database for Windows NT. This software 

must be available on one of the QALoad Player systems to compile the scripts.

Windows Player Requirements for Oracle Net8

The system running the Windows Player requires the following:

� Oracle Net8 or above client installation for playback.

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT 5.0 or higher.

� Oracle Net8 for Windows 95B or higher; or Windows NT, SP3 or higher (SP4 rec-

ommended).

� Oracle Net8 communications between the client application and the database. Typi-

cal Net8 development environments include products such as PowerBuilder, SQL-

Windows, Developer 2000, and ODBC-based systems.

� Microsoft’s Visual C++ 5.0 or 6.0. Note that you do not need to install any of the 

MFC components.

� Oracle OCI8 development environment for Windows NT. This is distributed with 

Oracle8’s PRO*C pre-compiler kit or with Oracle8’s database for Windows NT. 

This software must be available on one of the QALoad Player systems to compile 

the scripts.

Note

SQL*NET for Windows NT is a 32-bit version of SQL*NET. The Windows 3.1 version of 

SQL*NET, which you may use when capturing your client application, is a 16-bit version 

and cannot be used when running the QALoad Player software.
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Windows Player Requirements for Sybase

The system running the Windows Player requires the following:

� Windows client application based on Sybase 4.x or Sybase System 10.

� Windows 95B or later; Windows 98; or Windows NT, SP3 or higher (SP4 recom-

mended). Note that Sybase does not support Windows 2000.

� Sybase’s Open Client library for Windows. If your application uses DBLIB calls, 

you need to load the DBLIB libraries and header files. If you use Sybase’s newer 

CTLIB calls, you must load the appropriate CTLIB header files and libraries.

� Microsoft’s Visual C++ Version 5.0 or 6.0 compiler to compile the scripts.

Windows Player Requirements for SQL Server

The system running the Windows Player requires the following:

� Windows client application based on Microsoft’s SQL Server version 4.2, 6.0, or 

6.5.

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT, SP3 or 

higher (SP4 recommended).

� Microsoft’s Visual C++ Version 5.0 or 6.0 compiler for compiling the scripts.

� SQL Server C-development environment and SDK for Windows NT or Windows 

95.

Windows Player Requirements for ODBC

The system running the Windows Player requires the following:

� Windows client application that uses ODBC 2.0 drivers.

� Windows 95B or later; Windows 98; Windows 2000; or Windows NT, SP3 or 

higher (SP4 recommended).

�  (Optional) If a QALoad script uses ODBC to communicate to the database and you 

need to convert 16-bit captures to 32-bit, a 32-bit ODBC driver must be installed to 

perform this operation.

� Microsoft’s Visual C++ Version 5.0 or 6.0 compiler for compiling the scripts.

Windows Player Requirements for TUXEDO

The system running the Windows Player requires the following:

� Windows client application that uses TUXEDO V6.3 or later libraries (libwsc.lib, 

wtuxws32.lib, etc.).

� Complete Windows NT TUXEDO V6.3 or later workstation installation including 

\include and \lib directories.
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� TUXEDO environment variables must be set. TUXDIR, WSNADDR, and PATH 

must include the \bin directory found in TUXEDO’s root directory (TUXDIR).

� Microsoft’s Visual C++ Version 5.0 or 6.0 compiler for compiling the scripts.

Windows Player Requirements for UNIFACE

The system running the Windows Player requires the following:

� Development environment of UNIFACE NT 7.204 or higher, complete with the 

3GL interface.

� Valid UNIFACE NT Software Enable Key (SEK).

� Microsoft Visual C++ Version 5.0 ro 6.0 compiler for compiling the scripts.

QALoad UNIX Player Requirements

QALoad supports AIX 4.3 and above, Solaris 2.6 and above, and HP-UX 10.20and above. 

� Minimum of 0.5 MB RAM per virtual user.

� 100 MB minimum available storage device space.

� ANSI C compiler for compiling scripts.

� TCP/IP communications.

� Appropriate client application environment.

In addition, the UNIX system running the QALoad UNIX Player may need to meet 

specific requirements based upon which middleware you will be testing. For middleware-

specific requirements, see the following sections:

� “UNIX Player Requirements for Oracle” on page 5-6

� “UNIX Player Requirements for Sybase” on page 5-7

� “UNIX Player Requirements for TUXEDO” on page 5-7

UNIX Player Requirements for Oracle

The system running the UNIX Player requires the following:

� ANSI C compiler for compiling scripts.

� Oracle OCI development kit for UNIX installed on one of the QALoad Player sys-

tems to compile the scripts. The OCI development kit is distributed with Oracle’s 

PRO*C pre-compiler kit.

� SQL*NET communications between the client application and the database. Typi-

cal SQL*NET development environments include products such as PowerBuilder, 

Note

You must have a user ID set up on the Player system specifically to run the Player 

software. For example, set up a user ID (qaload) with a home directory of /usr/qaload or /

home/qaload.
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SQLWindows, Developer 2000, and ODBC-based systems. Applications developed 

in these environments allow for complete client-oriented capture.

UNIX Player Requirements for Sybase

The system running the UNIX Player requires the following:

� ANSI C compiler for compiling scripts.

� Sybase’s Open Client library for UNIX. If your application uses DBLIB calls or 

Microsoft’s SQL Server, you need to load Sybase’s DBLIB libraries and header 

files. If you use Sybase’s newer CTLIB calls, you must load the appropriate CTLIB 

header files and libraries.

UNIX Player Requirements for TUXEDO

The system running the UNIX Player requires the following:

� ANSI C compiler for compiling scripts.

� Client application that uses TUXEDO V6.3 or later libraries (libwsc.lib, 

wtuxws32.lib, etc.).

� Complete UNIX TUXEDO V6.3 workstation installation including \include and \lib 

directories.

� TUXEDO environment variables must be set. TUXDIR, WSNADDR, and PATH 

must include the \bin directory found in TUXEDO’s root directory (TUXDIR).

QALoad Installation

If you accept the default configuration, the following components are automatically 

installed as part of the QALoad Windows installation process:

� QALoad Conductor

� Windows Player, Player Agent, and IP Spoof Datapool Generator

� UNIX Players and Player Agent

� Script Development Workbench

� Analyze

� NetLoad Server Modules

� QALoad online help

� QALoad books online (You must have the Adobe Acrobat Reader installed on your 

system to access the QALoad books online.)

� QALoad README
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Installing Only the QALoad Components You Need

QALoad component-based installation allows you the freedom to determine which 

QALoad components to install. You may choose to install only the components that meet 

your needs. For example, you may only wish to install Player software on those worksta-

tions that will only be acting as Player Agent workstations where there is no need for a 

full QALoad installation. Or you may choose to install only the EasyScript component 

you are licensed for when you install the QALoad Script Development Workbench.

Complete the following steps to install QALoad from the QACenter CD.

1. If you are installing QALoad on a Windows NT machine, log on as a user with 

administrative privileges for that Windows NT machine.

2. Insert the QACenter installation CD in the CD-ROM drive. Setup starts automati-

cally, and the Compuware QACenter screen appears.

3. Click Install QACenter Products.

4. To proceed with the QALoad installation, click Install QALoad.

5. Read the QALoad Welcome screen and click Next. The QALoad License 

Agreement dialog box opens.

6. Read the QALoad License Agreement and click Yes to continue.

7. If this is a first time installation of QALoad, the Choose Destination Location dialog 

box opens. Go to Step 8.

If a previous installation of QALoad exists on this workstation, the QALoad Com-

ponent Selection dialog box opens. Go to Step 9.

8. On the Choose Destination Location dialog box, click Next to accept the default 

folder (normally c:\Program Files\Compuware\QALoad) or enter the appropriate 

path for a different folder, then click Next. 

9. On the QALoad Component Selection dialog box, select the QALoad components 

you wish to install.

If a previous installation of QALoad resides on the workstation, components that 

were installed with the previous installation are listed in grey for your reference.

a.  When the Books option is selected, the Setup program installs the complete 

QALoad online documentation set.

Note

If this is the first installation of QALoad on this machine, you must install a license key 

before you install the product. See Chapter 1, “Installing a Temporary License” for details 

on entering the license key. However, if you are only installing a Player on a machine that 

will only act as a Player Agent workstation, you do not need to install a license.
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b. With the Script Development Workbench highlighted, click the Change but-

ton to select the EasyScript components for which you are licensed. Compu-

ware recommends that you deselect the EasyScript components that you are not 

licensed for, as you will not be able to convert capture files with those compo-

nents.

c. With Player Files highlighted, click the Change button to select which Player 

Agents to install. If you choose to install the Windows Player, the IP Spoof 

Datapool Generator will be installed automatically.

d. With the NetLoad Server option selected, both the TCP and UDP server mod-

ules will be installed. 

e. Select Conductor to install the QALoad Conductor.

f. Select Analyze to install QALoad Analyze. If you have Compuware Central 

installed, you can publish Analyze reports to Compuware Central. Compuware 

Central can be installed from the QACenter Installation CD.

10. When you have finished making your selections, click Next. If the installation 

program cannot verify the location of your license file, installation will not be able 

to continue. If necessary, see Chapter 1, “Installing a Temporary License”.

11. If this is a first-time installation, the QALoad Program Folder Selection dialog box 

opens. Click Next to accept the default installation folder, \Compuware\QALoad.

12. The QALoad Setup Settings dialog box opens, allowing you to verify your selec-

tions. Click Next to continue. 

13. If a previous version of QALoad exists on this machine, the Prior Installation of 

QALoad dialog box opens. This dialog box contains important information about 

your existing QALoad files. After reviewing the information, click Next to 

continue, or Back to change your settings. 

14. When the installation is complete, the View Readme dialog box appears. Choose 

whether to review the information in the QALoad Readme file. This file contains 

information about licensing your copy of QALoad, new features in the product, 

notes and issues that may enhance or impact QALoad’s performance at your site, 

and information on how to contact Compuware. Click Finish.

15. If necessary, review and close the Readme file to continue with installation.

16. Click OK. Follow the prompts to complete the installation.

Note

If you purchased the EasyScript for Secure WWW module to test SSL (Secure Sockets 

Layer) or HTTPS calls that your browser/server may make, you will receive the 

appropriate encryption module on diskette. To install the module, insert diskette A into the 

floppy drive, then double-click the file setup.exe on the diskette. 
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Where To Go Next

� If Adobe Acrobat Reader is not installed on your workstation, return to the QALoad 

CD’s Products Installation dialog box and click the Get Acrobat button to launch 

Adobe’s installation program. You must have Adobe Acrobat Reader installed to 

view QALoad’s books online in PDF format.

� To install a Player Agent on an additional workstation, follow Steps 1-16 on the pre-

vious pages. However, on the QALoad Component Selection dialog box, select to 

install only the appropriate Player Agent and deselect all other components. 

� To install a UNIX Player Agent, see “UNIX Player Installation” on page 5-10.

� To obtain and install a permanent license for QALoad, see “Choosing a Permanent 

License Type” on page 9-1.

� To begin using QALoad, refer to the QALoad Testing User’s Guide.

UNIX Player Installation

This section explains the procedures for installing a Player on a UNIX system. The 

necessary UNIX Player software is distributed with your QALoad installation.

Load the Player Files

To load the DOS Player Agent file onto UNIX, you must FTP the files to the UNIX 

system and run the installation script. The files are located in the \Unix\<platform> 

directory of your QALoad installation (for example, c:\Program Files\Compuware 

\QALoad\Unix\Solaris).

1. If you are installing over a previous version of QALoad, shut down your existing  

Player Agent from a command prompt by typing the following: pl_agent -t 

2. Use the Run command to FTP to the UNIX Player system.

3. If necessary, change directories to where you would like to FTP the tar file and 

installation file.

4. Set the mode to binary by typing: binary.

5. Put the tar and install file onto the UNIX system by typing:
put <tarfile>

put <QALoadInstall>

Note

The following procedure assumes that you have obtained and installed a QALoad 

license. If you have not, see “Installing a Permanent License” on page 9-1.
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6. Type chmod 755 QALoadInstall.

7. Use the quit command to quit from FTP.

8. Log onto the UNIX system.

9. Run the file QALoadInstall and follow the prompts.

Where To Go Next

� To begin using QALoad, refer to the QALoad Testing User’s Guide.

Note

If you restart the UNIX system, you will have to start the Player Agent manually by typing 

pl_agent in the installation directory.
 



5-12     QACenter Installation and Configuration Guide
 



     6-1
Chapter 6.   Installing QADirector 2.3

You can install QADirector on a stand-alone workstation or on a shared network drive so 

that other users can run the product from their local workstations. This chapter includes 

the following sections:

� System Requirements — Hardware and software requirements for QADirector.

� Other Product Requirements — Minimum release requirements for other Compu-

ware products you can use with QADirector.

� Installation Overview — General steps required to install QADirector.

� Upgrading QADirector to a New Release — How to upgrade from a previous ver-

sion of QADirector.

� Installing QADirector on a Stand-alone Workstation — How to install QADirec-

tor on a single workstation so that one person can use it.

� Installing a Shared Network Copy of QADirector — How to install QADirector 

on a shared network drive so it can be run from multiple workstations.

� Modifying Product Options — How to change product options, such as which 

testing tools you are using, after installation.

System Requirements

� IBM or IBM-compatible PC with a 16 MB, 486/66 processor or above

� Microsoft Windows 95, Windows NT 3.51 or 4.0, Windows 3.1, or Windows 3.11

� MS DOS 5.0 or above if you are using Windows 3.1 or Windows 3.11

� VGA monitor and adapter.

� Disk space requirements:

• Stand-alone workstation installation: at least 25 MB

• Network installation: at least 20 MB

• Workstation installation from network: at least 8 MB
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Other Product Requirements

The following products may be required, depending on which Compuware automated 

testing tools you have.

� QAHiperstation Release 5.3.1 or above (Release 5.4 required to run MVS batch 

jobs)

� QAHiperstation+ Release 1.0.1 or above

� QARun 32-bit Release 4.1.2 or above

� QARun 16-bit Release 3.0 or above

� QAPlayback Release 5.6 or above

3270 Emulator

If you are using QAHiperstation or QAPlayback, or if you will be creating and executing 

MVS batch jobs, a 16-bit or 32-bit Windows 3270 terminal emulation software package 

is also required. For detailed information on the supported 3270 emulators and minimum 

version requirements, please read the QA3270 Emulator Server Readme.txt file or refer 

to the QADirector Hardware and Software Checklist you received with your order.

Installation Overview

These are the general steps required to install QADirector:

1. If this is your first installation of QADirector, you must install a temporary license 

key before you install the product as described in Chapter 1, “Installing a Tempo-

rary License”.

2. Identify whether the product will run on a stand-alone workstation or a network.

3. Determine the installation directory for the program files (or accept the default 

destination).

4. Follow the appropriate network or stand-alone installation procedure in this chapter.

5. If you are integrating QAHiperstation or QAPlayback with QADirector, you must 

install the QA3270 Emulator Server (if you have not already done so). To install the 

QA3270 Emulator Server, insert the QACenter CD. Click Install QACenter 

Products. Click Install QADirector. Click Install QA 3270 Emulator Server.
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Upgrading QADirector to a New Release

If you are upgrading QADirector, follow this procedure:

1. If you are installing QADirector on a Windows NT machine, you must log on as a 

user with administrative privileges for that Windows NT machine.

2. Before you upgrade QADirector, Compuware recommends that you back up your 

QADirector QADIR.DBM database and any other QADirector databases you may 

have created.

3. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products.

4. Click Install QADirector.

5. Click Install QADirector (16-bit) on the QACenter Products Installation screen. 

The Install Options dialog box appears.

6. Click Reinstall. The Install Type dialog displays:
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7. If you want to change the installation directory, click the Change Directory button 

and select the desired drive and directory. If you are re-installing QADirector on a 

network drive, you must change the directory to the appropriate network drive.

8. Click either the Standalone or Network button on the Install Type dialog box.

9. When installation is complete, you are prompted to view the Readme file.

10. If you are integrating QAHiperstation or QAPlayback with QADirector, you must 

install the QA3270 Emulator Server (if you have not already done so). To install the 

QA3270 Emulator Server, insert the QACenter CD, click the QADirector button, 

and then click the QA3270 Emulator Server button.

Installing QADirector on a Stand-alone Workstation

Use this procedure to install QADirector on a stand-alone workstation, which allows one 

person at a time to use the product.

1. Insert the QACenter CD into the CD-ROM drive. Click Install QACenter Prod-

ucts on the QACenter Products Installation screen.

2. Click Install QADirector.

3. Click Install QADirector (16-bit). The Setup dialog box appears.

4. Read the instructions on the QADirector Setup dialog box and click OK. The Install 

Type dialog box displays:

Hint

If you are re-installing QADirector on a network drive, you may not need to reinstall 

QADirector on each workstation. Refer to the QADirector Readme file for instructions.

Note

Before you install QADirector, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 4, “Installing a Permanent License” for 

instructions on installing a license.

Note

If QADirector cannot verify the location of your license key, you are prompted to enter the 

fully qualified path of your license key. You may enter the path and name for a license 

file, or you may enter a license server, for example, 7166@servername. If a license key 

is not set up, you must exit the installation program and refer to Chapter 1, “Installing a 

Temporary License” for details on entering the temporary license key.
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5. If you want to change the installation directory, click the Change Directory button 

and select the desired drive and directory.

6. Click the Standalone button on the Install Type dialog box. QADirector begins to 

copy the program files to the installation directory.

7. After the files are copied, you are prompted to select the automated testing tools you 

will be using with QADirector. Select the appropriate check boxes and click OK. 

Note that the testing tools listed in this dialog box may change, depending on which 

release of QADirector you are installing.

8. If prompted, enter additional setup information for the testing tools you selected.

9. By default, the QADirector icons are placed in a program group named Compuware 

QADirector. You can choose to place the icons in a different group or to enter a new 

program group name. When the program group is correct, click OK.

10. When installation is complete, you are prompted to view the Readme file.

11. If you are integrating QAHiperstation or QAPlayback with QADirector, you must 

install the QA3270 Emulator Server (if you have not already done so). To install the 

QA3270 Emulator Server, insert the QACenter CD. Click Install QACenter 

Products. Click Install QADirector. Click Install QA 3270 Emulator Server.
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Where To Go Next

� If you are ready to begin using QADirector, refer to the QADirector User’s Guide.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD browser and click Install 3rd Party Software, then click Install 

Adobe Acrobat Reader to launch Adobe’s installation program. You must have 

Adobe Acrobat Reader installed in order to view QADirector’s books online in PDF 

format.

Installing a Shared Network Copy of QADirector

Follow this procedure if you intend to install QADirector on a shared network drive and 

run it from multiple workstations. This installation is a two part process. First, you install 

QADirector on a network drive that is accessible by all users. Second, from each 

workstation where QADirector will be run, you perform an installation that copies certain 

program files from the network drive to the local workstation. This type of installation 

conserves local disk space because most program files are stored on the network drive.

Installing QADirector on a Network Drive

Use this procedure to install QADirector to a shared network drive, so that multiple users 

can run it from their local workstations. After you perform this procedure, you must 

perform an install procedure from each workstation where QADirector will be run. See 

“Setting up Each Workstation To Run the Shared Copy” on page 6-7.

1. Insert the QACenter CD into the CD-ROM drive. Click Install QACenter Prod-

ucts on the QACenter screen.

2. Click Install QADirector.

3. Click Install QADirector (16-bit) on the QACenter Products Installation screen. 

The Setup dialog box appears.

Note

If this is the first time you have installed QADirector on this machine, you must install a 

temporary license key before you install the product. See Chapter 1, “Installing a 

Temporary License” for details on entering the temporary license key.

Note

If QADirector cannot verify the location of your license key, you are prompted to enter the 

fully qualified path of your license key. You may enter the path and name for a license 

file, or you may enter a license server, for example, 7166@servername. If a license key 

is not set up, you must exit the installation program and refer to Chapter 1, “Installing a 

Temporary License” for details on entering the temporary license key.
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4. Read the instructions on the QADirector Setup dialog box and then click OK. The 

Install Type dialog box displays:

5. Click the Change Directory button and select the desired network drive and 

directory.

6. Click the Network button on the Install Type dialog box.

7. When installation is complete, you are prompted to view the Readme file.

8. To install required QADirector components from the network drive to a workstation, 

use the procedure in “Setting up Each Workstation To Run the Shared Copy”.

Setting up Each Workstation To Run the Shared Copy

After the system administrator installs QADirector on your site’s network drive, you must 

install certain QADirector program files on each workstation where QADirector will be 

run. Note that this procedure does not install the entire QADirector product on each 

workstation. Most of the program files will reside on the network drive.

1. Use Windows Explorer or File Manager to locate the network drive and path where 

QADirector was installed.

2. Double-click the Setup.exe file.

3. When the first setup screen displays, click OK. QADirector displays the QADirector 

Setup dialog box.
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4. If you want to change the installation directory, click the Change Directory button 

and select the desired drive and directory.

5. Click the Workstation button on the Setup dialog. QADirector begins to copy the 

necessary workstation files to the installation directory.

6. After the files are copied, you are prompted to select the automated testing tools you 

will be using with QADirector. Select the appropriate check boxes and then click 

OK. Note that the testing tools listed in this dialog box may change, depending on 

the QADirector release you are installing. 

7. If prompted, enter additional setup information for the testing tools you selected.

8. By default, the QADirector icons are placed in a program group named Compuware 

QADirector. You can choose to place the icons in a different group or enter a new 

program group name. When the program group is correct, click OK.

9. QADirector updates your system and creates program icons. When the installation is 

complete, you are prompted to view the Readme file.

10. If you are integrating QAHiperstation or QAPlayback with QADirector, you must 

install the QA3270 Emulator Server (if you have not already done so). To install the 

QA3270 Emulator Server, insert the QACenter CD. Click Install QACenter 

Products. Click Install QADirector. Click Install QA 3270 Emulator Server. Or 

check with your network administrator to see if the QA3270 Emulator Server was 

installed on the network.
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Where To Go Next

� If you are ready to begin using QADirector, refer to the QADirector User’s Guide.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD browser and click Install 3rd Party Software, then click Install 

Adobe Acrobat Reader to launch Adobe’s installation program. You must have 

Adobe Acrobat Reader installed in order to view QADirector’s books online in PDF 

format.

Modifying Product Options

You do not need to re-install QADirector to modify its product options. Use the following 

procedure to change product options such as adding another testing tool to use with 

QADirector.

1. Double-click the Change Options icon in the QADirector program group. The 

Automated Testing Tools dialog box appears with your previous selections dis-

played.

2. Select the appropriate check boxes for the automated testing tools you want to use 

with QADirector. Depending on which testing tools you have selected, you may be 

prompted to enter additional information.
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Chapter 7.   Installing QATrack

You can install QATrack on a stand-alone workstation, or you can install QATrack on a 

shared network drive so that other users can run the product from their local workstation. 

This chapter includes the following sections:

� System Requirements — Hardware and software requirements for installing 

QATrack.

� Upgrading to a New Release — How to upgrade from a previous version of 

QATrack.

� Installing QATrack on a Stand-Alone Workstation — How to install QATrack on 

a single workstation so that one person can use it.

� Installing a Shared Network Copy of QATrack — How to install QATrack on a 

shared network drive so it can be run from multiple workstations

System Requirements

� IBM or IBM-compatible PC with a 16 MB, 486/66 processor or above

� Microsoft Windows 95, Windows NT 3.51 or 4.0, Windows 3.1, or Windows 3.11

� MS DOS 5.0 or above if you are using Windows 3.1 or Windows 3.11

� CD-ROM drive

� VGA monitor and adapter

Upgrading to a New Release

If you are upgrading QATrack, follow the appropriate procedure in this chapter for 

installing QATrack on a stand-alone workstation or on a network drive. The installation 

will not overwrite your user database or other customized files.
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Installing QATrack on a Stand-Alone Workstation

Use this procedure to install QATrack on a stand-alone workstation, which allows one 

person at a time to use the product.

1. To install QATrack on a Windows NT machine, you must log on as a user with 

administrative privileges for that Windows NT machine.

2. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Explore this CD.

3. Navigate to the \CPWR\QATrack directory on the CD.

4. Double-click the setup.exe file. The Welcome screen appears.

5. Read the QATrack Welcome screen and click Next.

6. Read the software license agreement and click Yes if you accept. The Choose Desti-

nation Location dialog box appears.

7. By default, QATrack is installed in C:\CPWR\QATrack. To install to a different 

directory, click Browse and select another folder. When the destination directory is 

correct, click Next. The Setup Type dialog box displays these options:

• Network

• Standalone

8. Click Standalone and then click Next. The Select Program Folder dialog box 

appears.

9. By default, the setup program will add the QATrack program icons to the 

Compuware QATrack program folder. You may type a new folder name, or select 

one from the folder list. When the program folder is correct, click Next.

10. When the installation is complete, the Setup Complete dialog box appears. Click 

Finish to view the Readme file.

Where To Go Next

� If you are ready to begin using QATrack, refer to the QATrack User’s Guide.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD browser and click Install 3rd Party Software, then click Install 

Adobe Acrobat Reader to launch Adobe’s installation program. You must have 

Note

Before you install QATrack, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 4, “Installing a Permanent License” for 

instructions on installing a license.
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Adobe Acrobat Reader installed in order to view QATrack’s books online in PDF 

format.

Installing a Shared Network Copy of QATrack

Follow this procedure if you intend to install QATrack on a shared network drive and run 

it from multiple workstations. This installation is a two part process. First, you install 

QATrack on a network drive that is accessible by all users. Second, from each workstation 

where QATrack will be run, you perform an installation that copies certain program files 

from the network drive to the local workstation. This type of installation conserves local 

disk space because most program files are stored on the network drive.

Installing QATrack on a Network Drive

Use this procedure to install QATrack to a shared network drive, so that multiple users can 

run it from their local workstations. After you perform this procedure, you must perform 

an install procedure from each workstation where QATrack will be run. See “Setting up 

Each Workstation To Run the Shared Copy” on page 7-4.

1. If you are installing QATrack on a Windows NT machine, you must log on as a user 

with administrative privileges for that Windows NT machine.

2. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Explore this CD.

3. Navigate to the \CPWR\QATrack directory on the CD.

4. Double-click the setup.exe file. The Welcome screen appears.

5. Read the QATrack Welcome screen and click Next.

6. Read the software license agreement and click Yes if you accept.

7. On the Choose Destination Location dialog box, click Browse and select the 

network folder. When the destination directory is correct, click Next. The Setup 

Type dialog box displays these options:

• Network

• Standalone

8. Click Network and then click Next. QATrack begins to copy the program files to 

the destination directory on the network.

Note

Before you install QATrack, you must have a valid license installed. See Chapter 1, 

“Installing a Temporary License” or Chapter 4, “Installing a Permanent License” for 

instructions on installing a license.
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9. When installation is complete, the Setup Complete dialog box appears. Click Finish 

to view the Readme file.

10. To install required QATrack components from the network drive to a workstation, 

use the procedure in “Setting up Each Workstation To Run the Shared Copy”.

Setting up Each Workstation To Run the Shared Copy

After the system administrator installs QATrack on your site’s network drive, you must 

install certain QATrack program files on each workstation where QATrack will be run. 

Note that this procedure does not install the entire QATrack product on each workstation. 

The majority of the program files will reside on the network drive.

1. If you are installing QATrack on a Windows NT workstation, you must log on as an 

administrator.

2. Use Windows Explorer or File Manager to locate the network drive and path where 

QATrack was installed.

3. In the Setup folder, double-click the setup.exe file. The Welcome screen appears.

4. Read the instructions on the Welcome screen and click Next.

5. Read the software license agreement and click Yes if you accept. The Choose Desti-

nation Location dialog box appears.

6. By default, QATrack is installed in C:\CPWR\QATrack. To install to a different 

directory, click Browse and select another folder. When the destination directory is 

correct, click Next. The Select Program Folder dialog box appears.

7. By default, the setup program adds the QATrack program icons to the Compuware 

QATrack program folder. You may type a new folder name, or select one from the 

folder list. When the program folder is correct, click Next.

8. When the installation is complete, the Setup Complete dialog box appears. Click 

Finish to view the Readme file.

Where To Go Next

� If you are ready to begin using QATrack, refer to the QATrack User’s Guide.

� If Adobe Acrobat Reader is not installed on your workstation, return to the 

QACenter CD browser and click Install 3rd Party Software, then click Install 

Adobe Acrobat Reader to launch Adobe’s installation program. You must have 

Note

You must configure your product license before you install QATrack on a workstation. 

See “Choosing a Concurrent-User License” on page 4-7 for instructions on installing a 

license on a workstation.
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Adobe Acrobat Reader installed in order to view QATrack’s books online in PDF 

format.
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Chapter 8.   Installing Compuware Central

Compuware Central is a browser-based utility that lets you view report data generated by 

QARun, QALoad, and WebCheck. Any workstation with Internet Explorer 4.0 or above 

can view reports published to Compuware Central. This chapter explains how to install 

the Compuware Central server and client components. It includes the following sections:

� System Requirements — Hardware and software requirements for installing Com-

puware Central.

� Compuware Central Installation — Instructions for installing Compuware Cen-

tral’s server and client components.

� Changing UNC Name and URL to Compuware Central — Instructions for using 

the Compuware Central Configuration utility to maintain access to Compuware 

Central if its server location changes.

System Requirements

For the server running Compuware Central:

� Internet Information Server 4.0 or above

� Sufficient disk space for reports generated by QACenter products in HTML format.

For each client accessing reports published to Compuware Central:

� Internet Explorer 4.0 or above to view reports published to Compuware Central

� IBM or compatible PC with a 486 processor or above (Pentium recommended)

� 32 MB of RAM for Windows 95, Windows 98, or Windows NT 4.0

� Access to the Compuware Central client setup program on the server.
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Compuware Central Installation

The Compuware Central installation has two main procedures:

Installing Compuware Central on the Server — Installs Compuware Central’s server 

components and creates the setup program used to install Compuware Central on a client 

workstation. It also installs the Compuware Central Configuration utility, which the 

system administrator can use to reset the Universal Naming Convention (UNC) name and 

URL for accessing Compuware Central.

Installing Compuware Central on a Client Workstation — Installs Compuware 

Central on a client workstation.

Installing Compuware Central on the Server

The server installation process sets up the general locations (the UNC name and URL) on 

the server where Compuware Central clients store and access reports published in HTML 

format. It also installs the Compuware Central Configuration utility on the server, and the 

setup program that the clients must access to install the Compuware Central client. The 

client setup program is located in a folder called setup, which is a sub-folder of the desti-

nation location for the Compuware Central Configuration utility. Once created by the 

server installation, both the setup folder and the location where Compuware Central 

clients store and access HTML reports on the server must be shared to provide client 

access.

To perform the server installation of Compuware Central, follow these steps.

1. On the server machine on which you are installing Compuware Central, insert the 

QACenter CD into the CD-ROM drive.

The QACenter setup should automatically start. If it does not, use Windows 

Explorer to navigate to the setup program, located in the Compuware Central folder 

on the CD.

2. Click Install QACenter Products.

Note

You must  log on as a user with administrator privileges to install Compuware Central to a 

server.
 



Installing Compuware Central     8-3
3. Click Install Compuware Central. The Compuware Central install program starts 

and displays the Welcome dialog box.

4. After reviewing information in the Welcome dialog box, click Next. The 

Compuware Central Software License Agreement dialog box displays.

5. Read the software license agreement and click Yes to accept the terms of the 

agreement. The User Information dialog box displays with the name of the user and 

company taken from the registry.

6. Click Next to confirm the Name and Company values are correct. The Choose 

Destination Location dialog box displays.

7. Select a location for the Compuware Central Configuration utility. By default, the 

Compuware Central Configuration utility for the server installs to C:\Program 

Files\Compuware\Central. To specify a different location, click the Browse button 

and select an existing directory.

8. Click Next. The Enter Locations dialog box displays the default locations for the 

UNC path name and URL where clients will store and access the QACenter reports 

published in HTML format. The defaults are:

UNC Name: \\[machine name]\Compuware Central

URL: http://[machine name]/slc

Where machine name is the server name as recognized by your network.

9. Click Next. The Compuware Central Shortcut Folder dialog box displays. Verify 

the location where the program icons will be added.

10. Click Next. The Start Copying Files dialog box displays and allows you to review 

your installation selections.

11. Click Next to begin the installation. The installation copies Compuware Central 

Configuration utility program files to the specified destination, as well as program 

Note
The

The Compuware Central server requires that Microsoft’s Internet Information Server 4.0 

or above be installed on the server machine. If the installation program does not detect 

Internet Information Server 4.0 or above, it issues a message that a compatible Web 

server is not installed. If this happens, click OK to abort the installation. Install Internet 

Information Server 4.0 or above on the machine, then restart the Compuware Central 

installation from the QACenter CD.

Note

The destination location in this dialog box is the location for the Compuware Central 

Configuration Utility only. During installation, setup detects the location of the wwwroot 

folder on the server. Compuware Central program files are copied to a new sub-folder of 

wwwroot called /slc.
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files for Compuware Central. The server installation also creates a sub-folder called 

setup. The setup sub-folder contains the Compuware Central client installation 

setup program.

12. When the server installation completes, the Setup Complete dialog box displays. 

Click Finish to complete the server installation of Compuware Central. Proceed to 

“Sharing Folders on the Server” to share the necessary folders on the server for the 

client installation.

Sharing Folders on the Server

Before performing the client installation of Compuware Central, you must share the 

folders on the server where the setup files are located and the reports will be stored. 

Sharing these folders allows the client machines to access the client installation program 

of Compuware Central and to store and access HTML reports in Compuware Central.

1.  On the server machine, share the following directory:

\Program Files\Compuware\Central\Setup

Access this setup directory from client machines by mapping to:

\\[machine name]\[setup folder]

Where machine name is the machine name of the server and setup folder is the 

folder that contains the Compuware Central client setup program (... \Program 

Files\Compuware Central\Setup is the default). This allows client users to access the 

client setup program.

2. On the server machine, share the following directory:

\\[machine name]\Inetpub\wwwroot\slc\Data\Channels\Public Channels

This directory contains the tree structure used by Compuware Central to store 

HTML reports generated by QACenter products. Sharing the folder allows clients to 

write HTML reports for viewing in Compuware Central. Refer to your Windows 

documentation for instructions on sharing folders.

Client machines can access this directory by mapping to:

\\[machine name]\Compuware Central

3. To install Compuware Central on a client machine from the server installation, 

follow the procedure in “Installing Compuware Central on a Client Workstation” on 

page 8-5.
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Installing Compuware Central on a Client Workstation

The Compuware Central client installation installs the Compuware Central client from a 

shared folder on a server to a workstation. The installation creates registry entries that 

contain the location to access reports in Compuware Central written by QACenter 

products. Perform the following procedure on each client workstation to install 

Compuware Central.

1. In Windows Explorer, map a network drive to the directory on the server where 

Compuware Central is installed.

2. Navigate to the Compuware Central setup folder on the server where Compuware 

Central is installed. This folder should be \\[machine name]\[setup folder], where 

machine name is the name of the server where Compuware Central is installed. This 

folder was shared in step 2 of “Sharing Folders on the Server”.

3. Double-click the SETUP.EXE file located in the Setup folder. The Compuware 

Central client installation program starts and displays the Welcome dialog box.

4. After reviewing information in the Welcome dialog box, click Next. The 

Compuware Central Software License Agreement dialog box displays.

5. Read the software license agreement and click Yes to accept the terms of the 

agreement.The User Information dialog box displays with the name of the machine 

and company name taken from the registry.

6. Click Next to confirm the Name and Company values are correct. The Choose 

Destination Location dialog box displays.

7. Select a location for the Compuware Central Configuration utility. By default, the 

Compuware Central Configuration utility is installed to C:\Program 

Files\Compuware\Central. To specify a different location, click the Browse button 

and select an existing directory.

8. Click Next. The Enter Locations dialog box appears, displaying the UNC Name and 

URL to access locations. Verify that the locations are correct.

9. Click Next. The Compuware Central Shortcut Folder dialog box displays. Verify 

the location where the program icons will be added.

10. Click Next. The Start Copying Files dialog box displays and allows you to review 

your installation selections.

Caution

Do not change the UNC name and URL listed in this dialog box unless you are instructed 

to do so by the system administrator. Changing these values could result in losing access 

to Compuware Central.
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11. Click Next to begin installing the program files. When the client installation 

completes, the Setup Complete dialog box displays. Click Finish to complete the 

client installation of Compuware Central.

Changing UNC Name and URL to Compuware Central

At times it may be necessary to change the UNC path name and URL used to access 

Compuware Central. The Compuware Central Configuration Utility allows you to reset 

the UNC Path and URL without having to reinstall Compuware Central.

Complete the following procedure on both the server where Compuware Central resides 

and each client workstation that accesses Compuware Central. As with the client instal-

lation, the system administrator can perform the server procedure, then send instructions 

to users to perform the procedure on their workstations.

1. Start the Compuware Central Configuration utility:

• From the Windows taskbar, click the Start button and choose Pro-

grams>Compuware>Central.

• Select Compuware Central Configuration Utility from the program group. 

The Configuration utility displays current values in the UNC Name and URL 

fields.

2. Type the new UNC Path and URL where Compuware Central can be accessed.

3. Click OK.

4. Perform steps 1 through 3 on the client workstations.
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Chapter 9.   Installing a Permanent License

To run your QACenter product without interruption, you must install a valid permanent 

license, which provides access to the product for a single or multiple users under the terms 

of your contract with Compuware. There are two types of Compuware licenses:

� A temporary license is the default license shipped with the product. This type of 

license gives an unlimited number of users access to the product for a limited time 

period, allowing you to use the product on a trial basis. For more information, see 

Chapter 1, “Installing a Temporary License”.

� A permanent license gives you access to the product under the terms of your con-

tract with Compuware. Compuware offers two types of permanent licenses: single-

user and concurrent-user. Each of these types is described below.

Choosing a Permanent License Type
Two types of permanent license are available. The type of license you choose depends 

upon the specific needs of your site.

� Single-User — If you only need one copy of the QACenter product on one worksta-

tion, a permanent single-user license should meet your needs. This type of license 

allows the product to run on a single workstation. The product cannot be used on 

any other workstation.

� Concurrent-User — If you need to run the QACenter product on more than one 

workstation so multiple users can access it, a permanent concurrent-user license 

should best meet your needs. This type of license is installed on a machine that acts 

as a server to any number of workstations that have access to it. It allows a pre-

determined number of users on different workstations to use a product at the same 

time. You can install the product on any number of workstations. Your license deter-

mines how many users may access the product at a time.

Note

Please note that Compuware Central does not require a license. If you are only installing 

Compuware Central proceed to Chapter 8, “Installing Compuware Central”.
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To obtain a permanent license, you must provide Compuware with the host name (for 

concurrent-user licenses only) and host ID of the machine on which you installed the 

product or the Compuware LM. This machine may be a single workstation for a single 

user, or a machine that acts as a server for concurrent users. Compuware provides you 

with a permanent license that is customized for your needs.

As you consider which type of permanent license you need, keep in mind that each 

product license is individually created to work on a specific machine. It cannot be trans-

ferred to another machine. After you determine which type of license best fits your needs, 

proceed to the appropriate installation instructions:

� “Installing a Single-User License on Windows 95, 98, or NT” on page 9-2.

� “Installing a Single-User License on UNIX or Windows 3.1x” on page 9-5

� “Choosing a Concurrent-User License” on page 9-7.

Installing a Single-User License on Windows 95, 98, or NT 
Complete the following tasks to install a permanent single-user license:

� Determine the host name and ID of the machine where the QACenter product is 

installed.

� Obtain the permanent license.

� Enter the license information in the license file.

Detailed instructions for performing these tasks are provided in this section.

Determining the Host Name and ID

1. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products. The QACenter Products installation screen appears.

2. Click Run License Administration Utility. The License Administration Utility 

(LAU) opens, displaying the host name and host ID of the machine at the bottom of 

the dialog box.

Caution

A single-user license is valid for one workstation only — the workstation with the host ID 

you supply to Compuware. You cannot use the license on any other workstation.
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3. To save the host information to a file, select Save Host Information from the Tools 

menu. By default the file is named hostinfo.txt. Navigate to the directory you 

want to save the file in and click Save.

Obtaining License Information

After you obtain the host information, contact your Compuware Sales Representative to 

obtain the required single-user license information. You can also e-mail the file 

hostinfo.txt to license_mgt@compuware.com to obtain a permanent license. 

Compuware will provide you with personalized license information by e-mail, fax, or 

regular mail.

Entering License Information

After you receive the permanent license from Compuware, you need to enter the license 

information into your license file. To do this you will use the License Administration 

Utility (LAU) on the QACenter CD-ROM.

1. Check for the existence of a license file on the machine:

• If a Compuware product is already installed on this machine, find the license 

file. It should be named license.dat and be in the directory \Program Files\Com-

puware\License (or \cpwr) on the drive where the product is installed.

• If a license file does not exist for a Compuware product, create a directory on 

the drive where your operating system is installed called \Program Files\Com-

puware\License. This directory may have already been created for a temporary 

license or another Compuware product. You will install your permanent license 

in this directory.

2. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products. The QACenter Products installation screen appears.

3. Click Run License Administration Utility. On the LAU main window, click 

Install License. The Install License Files dialog box appears.

Note

You should save the host information to a file if you want to keep a record of it. You can 

also e-mail this file to license_mgt@compuware.com to obtain a permanent license 

for your Compuware product. See “Obtaining License Information” on page 9-3.
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4. Click the Browse button next to the Product License File field to navigate to the 

product license file. This is the permanent license file that you received from 

Compuware.

5. Click the Browse button next to the Master License File field to navigate to the 

master license file. This file is called license.dat and is in the directory \Program 

Files\Compuware\License (or \cpwr). If you just created the license directory in 

Step 1, navigate to it and create a new file by typing license.dat in the File Name 

field. Click Open to select the new license file as your master file.

6. Click Install License. This installs the product license file to your master license 

file. A message appears when the file has been successfully installed.

Setting the Environment Variable

Check that the environment variable called LM_LICENSE_FILE is set. If it is not set, use 

the appropriate procedure below to set it.

Windows 95, or 98:

1. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products. The QACenter Products installation screen appears.

2. Click Run License Administration Utility. From the Tools menu on the LAU 

main window, choose Set License Location. The Set License File Variable dialog 

box displays the current environment variable setting.

3. If the variable LM_LICENSE_FILE is not set to the license.dat file, click the 

Browse button and navigate to the license file. Click Open to add the file to the 

LM_LICENSE_FILE variable.

4. Click OK to save your changes. LAU sets the entry LM_LICENSE_FILE in your 

autoexec.bat file.
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5. When prompted to create a backup of your autoexec.bat file, click Yes. The back up 

file is named autoexec.0XX (where X=1 through 99).

6. Reboot the computer for the changes to take effect.

Windows NT:

In Windows NT, you must set the environment variable from the System Properties dialog 

box in the Windows control panel.

1. From the Start menu, select Settings>Control Panel>System. On the System dia-

log box, click the Environment tab.

2. In the Variable field, type LM_LICENSE_FILE.

3. In the Value field, type the fully qualified path of your license file. C:\Program 

Files\Compuware\License\license.dat (or \cpwr\license.dat). Click the Set button.

4. Reboot the computer for the changes to take effect.

Installing a Single-User License on UNIX or Windows 3.1x 
Complete the following tasks to install a permanent single-user license:

� Determine the host ID of the workstation where the QACenter product is installed.

� Obtain the permanent license.

� Enter the license information in the license file.

Detailed instructions for performing these tasks are provided in this section.

Determining the Host ID

1. If necessary, create a directory on the drive where your operating system is installed 

called \cpwr, or �cpwr/license on UNIX platforms. This directory may have already 

been created for the temporary license or another Compuware product.

2. Copy the contents of the appropriate subdirectory on the QACenter CD-ROM to the 

license directory you created on the machine:

Windows: Copy the contents of directory \cwlm\cwlmw32.xx, where xx is a version 

number of the license program.

UNIX: Copy the appropriate files of the platform-specific subdirectory within the 

directory /cpwr/cwlm.

Caution

A single-user license is valid for one workstation only — the workstation with the host ID 

you supply to Compuware. You cannot use the license on any other workstation.
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3. Change to your license directory:

Windows: Open a DOS session and change to the directory \cpwr.

UNIX: Change to the directory �cpwr/license.

4. Type: lmutil lmhostid. A host ID message like the following is displayed: 
The FLEXlm host ID of this machine is “00c04fd9ed02”

5. Record the host ID for use in the next procedure, “Obtaining License Information”.

Obtaining License Information

After you obtain the host information, contact your Compuware Sales Representative to 

obtain the required single-user license information. You can e-mail the host information 

to license_mgt@compuware.com to obtain a permanent license. Compuware will 

provide you with personalized license information by e-mail, fax, or regular mail.

Entering License Information

After you receive the permanent license from Compuware:

1. Check for the existence of a license file on the machine:

• If a Compuware product is already installed on this machine, find the license 

file. It should be named license.dat, and should be in the directory \cpwr (or 

�cpwr/license on UNIX platforms) on the drive where the product is installed. 

Open the license file in a text editor such as Notepad or vi and go to Step 4.

• If the product is not installed on this machine, check to see if a license.dat file 

already exists on the machine for a Compuware product. If it already exists, use 

that file for the QACenter product. Open the license file in a text editor such as 

Notepad or vi and go to Step 4.

•  If a license file does not exist for a Compuware product, go to Step 2.

2. On the drive where your operating system is installed, create a directory called 

\cpwr (or �cpwr/license on UNIX platforms).

3. Create a file called license.dat using a text editor such as Notepad, and save it in the 

directory you created in Step 2.

4. If you received the license string via e-mail, paste it from the e-mail into the license 

file. If not, type it into the license file. Commented information (preceded with a #) 

is for your reference only; you do not need to include it in the file.

Caution

Enter the license information exactly as you received it. This information is case sensitive.
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• If you are entering the first license in the file: Enter the license information 

you received, as in the following example:

• If the license file is already used for a product: Append only the lines begin-

ning with FEATURE and ending with ck=##, where ## is a numeric string, to 

the end of the license file. For File-AID/CS, also include the PACKAGE line.

5. Save your changes to the license file and exit the text editor.

6. Check that the LM_LICENSE_FILE environment variable is set to the path to the 

license file. If it is not set, use the appropriate procedure below. These procedures 

assume that the file is in the directory c:\cpwr (Windows) or /cpwr/license (UNIX).

Windows 3.1x:

Using a text editor, open the autoexec.bat file and add the following line.

set LM_LICENSE_FILE=c:\cpwr\license.dat

UNIX:

Set the LM_LICENSE_FILE environment variable in the user profile file to the 

path to the license file, as shown in either of these two examples: 

.

7. For Windows workstations, reboot the machine for these changes to take effect.

Choosing a Concurrent-User License 
Concurrent-user licensing allows you to purchase a specific number of licenses without 

assigning these licenses to particular workstations. Instead, licenses are “checked out” by 

users on a first-come, first-served basis when they access the product. When all available 

licenses are issued, no additional users can run the product until another user exits and a 

license is “checked in.” This request-and-issue process is managed by the Compuware 

License Manager (LM). The LM must be running on a computer or server that is always 

available to all client workstations needing access to the product.

SERVER ServerName 0020af9adb94 TCP:7166
DAEMON compuware compuwar
FEATURE QARun Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\
VENDOR_STRING=989898;0;PERM ck=12

Hint
I

If the LM_LICENSE_FILE variable is already defined for a product, type a semicolon 

(Windows) or colon (UNIX) to separate previously set paths. Then type the path to the 

QACenter license file. For example: LM_LICENSE_FILE=c:\mccabe\license.dat; 

C:\Program FIles\Compuware\License\license.dat.

setenv LM_LICENSE_FILE=/full-path-to-license-file/license.dat (csh)

-export LM_LICENSE_FILE=/full-path-to-license-file/license.dat (ksh)
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Selecting the Compuware License Manager Server 

If you are installing a permanent license for concurrent users, the Compuware LM must 

be running on a stable Windows (95, 98, or NT) or UNIX machine that is hereafter 

referred to as the License Manager server (LM server). The LM server is a computer or 

server machine that is always available to users. It does not have to be an actual network 

server, but it must be a machine to which the entire network or group of people using the 

QACenter product has access. Before contacting Compuware for a permanent concurrent-

user license, you must select a machine on which to install the Compuware LM. This 

machine will be your LM server.

If the LM is already installed for a Compuware product, you may not need to re-install it. 

You can use one LM server for multiple Compuware products. For more information, see 

the appropriate section for your platform:

� Windows — See “Installing a Concurrent-User License on Windows” on page 9-8.

� UNIX — See “Installing a Concurrent-User License on UNIX” on page 9-15.

� Novell TCP/IP — See “Installing a Concurrent-User License on Novell TCP/IP” 

on page 9-19.

� Novell IPX/SPX — See “Installing a Concurrent-User License on Novell IPX/

SPX” on page 9-24.

Installing a Concurrent-User License on Windows
Complete the following tasks to install a permanent concurrent-user license:

� Determine the host name and ID of the machine that will be the LM server.

� Obtain the permanent concurrent-user license.

� Install or update the LM.

� Install the permanent license on the LM server.

� Configure the LM for automatic startup.

� Configure each user workstation that will access the LM server.

� If necessary, configure the LM for manual shutdown.

Detailed instructions for performing these tasks are provided in this section.

Determining the Host Name and ID

In order to receive a permanent license, you must supply Compuware with the host name 

and the host ID of the machine on which the license will be installed.
 



Installing a Permanent License     9-9
1. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products.

2. Click Run License Administration Utility. The License Administration Utility 

(LAU) opens, displaying the host name and host ID of the machine at the bottom of 

the dialog box.

3. To save the host information to a file, select Save Host Information from the Tools 

menu. By default, the file is named hostinfo.txt. Navigate to the directory in 

which you want to save the file and click Save.

Obtaining License Information

After you obtain the host information, contact your Compuware Sales Representative to 

obtain the required single-user license information. You can also e-mail the host infor-

mation to license_mgt@compuware.com to obtain a permanent license. Compuware 

will provide you with personalized license information by e-mail, fax, or regular mail.

Installing or Updating the License Manager

The machine on which a concurrent-user license and the LM is installed is called the LM 

server. It must always be available to workstations using Compuware products because it 

monitors product licensing. For more information, see “Selecting the Compuware 

License Manager Server” on page 9-8.

� If this is a first-time installation of the LM on this machine, go to “Installing the 

LM” on page 9-9.

� If a previous version of the LM is on this machine, you may need to install the cur-

rent version. Go to “Updating the LM” on page 9-10.

Installing the 

LM

Use this procedure to complete a first-time installation of the LM:

1. Insert the QACenter CD and click Install QACenter Products. Click Install Com-

puware LM.

2. The Welcome dialog box opens. Click Next.

3. Read the Software License Agreement and click Yes if you accept.

4. The Choose Destination Location dialog box displays the directory where the LM 

will be installed: \Program Files\Compuware\License. Click Next.

Note

You should save the host information in a file if you want to keep a record of it. You can 

also e-mail this file to license_mgt@compuware.com to obtain a permanent license for 

your Compuware product. See “Obtaining License Information” on page 9-9.
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c.
5. By default, the setup program will add the LM program icons to the 

Compuware>License Management folder. You can choose a different folder. When 

the folder is correct, click Next.

6. On the Start Copying Files dialog box, verify the installation settings and click 

Next.

7. When the installation is complete, the Setup Complete dialog box appears. If you 

have the permanent license, you can install it now. If you install the license now, 

you can configure the LM for automatic startup when you are finished.

• If you do not have a permanent license for your QACenter product, deselect the 

Install License option and click Finish. See “Determining the Host Name and 

ID” on page 9-8 for information on receiving a permanent license.

• To install your permanent license, select the Install License option and click 

Finish. The LAU opens. See Step 3 of “Installing a Permanent License”.

Updating the 

LM 

If the LM is already installed, you may not need to install it again because it can be used 

for multiple Compuware products. Before you re-install the LM, check its version 

number to determine if it is the latest version available to you. If you just installed the LM 

for another Compuware product, you have the current version and do not need to update 

it. Complete the following procedure to determine the version that is running on the LM 

server.

1. Open a DOS window and change to the directory where the LM is located.

2. At the DOS prompt, enter: lmutil lmver lmgrd.exe. A message like the 

following displays the FLEXlm version number of the LM: 

3. Insert the QACenter CD in the CD-ROM drive. At the DOS prompt, change to the 

CD-ROM drive and enter lmutil lmver lmgrd.exe again.

4. Compare the version number returned from the server with that on the CD-ROM:

• If the version number returned from the server is higher than the version on the 

CD-ROM (for example, if your LM version is 5.12 and that on the CD-ROM is 

5.0), do not update the LM.

• If the version number returned from the server is below that on the CD-ROM, 

you need to update your version of LM.

5. To update the LM, insert the QACenter CD and click Install QACenter Products. 

On the QACenter Products installation screen, click Install Compuware LM. The 

Setup program will install the new version of the LM.

lmutil - Copyright (C) 1989-1997 Globetrotter Software, Inc.
FLEXlm Copyright 1988-1996, Globetrotter Software, Inc.
FLEXlm 5.12a (libmgr_s.a), Copyright (C) 1988, 1997 Globetrotter Software,In
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Installing a Permanent License

After you receive the permanent license from Compuware, you need to enter the license 

information into your license file. To do this you will use the LAU. If you have not 

installed the Compuware License Manager, you must do that before you install your 

license. For information, see “Installing the LM” on page 9-9.

1. From the Start menu, select Programs>Compuware>License Manage-

ment>License Administration Utility. Or, using Windows Explorer, navigate to 

the directory \Program Files\Compuware\License (or \cpwr). Double-click the icon 

for the file LAU.exe to start the LAU.

2. On the LAU main window, Click Install License. The Install License dialog box 

appears.

3. Click Browse to navigate to the product license file. This is the permanent license 

file you received from Compuware.

4. Click Browse to navigate to the master license file. This file is called license.dat 

and is located in the directory \Program Files\Compuware\License (or \cpwr). If you 

do not have a license file for another Compuware product, navigate to the directory 

\Program Files\Compuware\License (or \cpwr) and create a new file by typing 

license.dat in the File Name field. Click Open to select the new license file as your 

master license file.

5. When you have selected the correct product and master license files, click Install 

License. This installs the product license file to your master license file. A message 

appears when the file has been successfully installed. Click OK.

6. Click the Exit button on the LAU main window. The Setup Finished dialog box 

appears. You may restart the computer at this time, or you can choose to restart it 

later.

Configuring the License Manager for Automatic Startup

Because all license validation is done by the LM, it must be started and kept running in 

order to use Compuware products. Complete the appropriate procedure to automatically 

start the LM each time the LM server is started.

Note

For Windows NT 4.0 and above, Compuware recommends that automatic LM startup be 

set up as an NT service. NT service installation should be performed by, or in the 

presence of, a certified Windows NT Administrator.
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Windows NT 4.x 

as NT Service

1. Update the DAEMON line in the license file so that it contains the full path of the 

compuwar.exe, for example:

DAEMON compuware c:\Program
Files\Compuware\License\compuwar.exe

2. At a DOS prompt, change to the directory where the LM is located (\Program 

Files\Compuware\License). Type the following command on one line:

where c:\Program Files\Compuware\License is the directory where the LM is 

located and license.dat is the name of your license file. (Your license.dat file 

may reside in\cpwr\license.dat.)

3. Compuware LM now appears in the list of services. To start it, reboot the NT server. 

If you do not want to reboot the NT server, you can manually start the LM by 

selecting it from the services list.

Windows 95, 

98, or NT 4.x in 

Startup Folder

1. Select Start>Settings>Taskbar. On the Start Menu Programs tab, click the Add 

button. The Create Shortcut window is displayed.

2. In the Command Line box, type:

where c:\Program Files\Compuware\License is the directory where the LM is 

located and license.dat is the name of your license file.(Your license.dat file 

may reside in\cpwr\license.dat.)

3. Click Next. The Select Program Folder dialog box appears.

4. Select the Startup folder and click Next. The Select a Title for the Program dialog 

box appears. Type: Startup Compuware License Manager.

5. Click Finish, then click OK.

6. Use Windows Explorer to navigate to the Startup directory. For example, in 

Windows 95, go to: c:\Windows\Start Menu\Programs\Startup.

7. Right-click on the Startup Compuware License Manager entry and select 

Properties from the menu.

8. Click the Shortcut tab and select Minimized from the Run list.

9. Click Apply, then click OK.

10. Reboot the machine or click the shortcut icon for these changes to take effect.

installs -e c:\Program Files\Compuware\License\lmgrd.exe -c
c:\Program Files\Compuware\License\license.dat -l
c:\Program Files\Compuware\License\lmgrd.log

c:\Program Files\Compuware\License\lmgrd.exe -app -c c:\Program
Files\Compuware\License\license.dat
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Windows NT 

3.51

1. Highlight the Startup icon.

2. Select File>New>Program Item and click OK.

3. In the Description fields, type: Startup Compuware License Manager.

4. In the Command line field, type:

c:\Program Files\Compuware\License\lmgrd.exe -app -c

c:\Program Files\Compuware\License\license.dat

where c:\Program Files\Compuware\License is the directory where the LM is 

located and license.dat is the name of the license file.(Your license.dat file may 

reside in \cpwr\license.dat.).

5. Select the Run Minimized check box and click OK.

6. Reboot the machine or click the shortcut icon for these changes to take effect.

Configuring Each User Workstation

Each workstation on which the product will be run with the concurrent-user license must 

be configured to access the LM server. Complete the appropriate procedure on each 

workstation to set the LM_LICENSE_FILE environment variable.

Windows NT 4.x 1. From the Start menu, select Settings>Control Panel>System>Environment.

2. In the Variable field, type LM_LICENSE_FILE.

3. In the Value field, type 7166@hostname where hostname is the host name of the 

LM server. This value must match that of the first parameter of the SERVER line in 

the license file on the LM server.

4. Click the Set button. Reboot the machine for these changes to take effect.

Windows 95, 

98, or NT 3.51

1. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products. On the Install QACenter Products screen, click Run 

License Administration Utility. The LAU opens.

2. From the Tools menu on the LAU main window, choose Set License Location.

3. Click the Browse button and navigate to the LM server. Click Open to add the file 

to the LM_LICENSE_FILE variable.

4. Click OK. Reboot the machine for these changes to take effect.
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Windows 3.1x 1. Using a text editor, open the autoexec.bat file and add the following line (with no 

spaces). Type the line exactly as you see it; this information is case sensitive.

set LM_LICENSE_FILE=7166@hostname

where hostname is the host name of the LM server. This value must match that of 

the first parameter of the SERVER line in the license file on the LM server.

2. Reboot the machine for these changes to take effect.

Configuring the License Manager for Manual Shutdown

On occasion, you may need to shut down the LM manually. This section describes how 

to set up an entry to do this before exiting Windows.

Windows 95, 

98, or NT 4.x

1. Select Start>Settings>Taskbar. On the Start Menu Programs tab, click the Add 

button. The Create Shortcut window is displayed. 

2. In the Command Line box, type the path where the LM is located, followed by the 

command shown in the example below:

where c:\Program Files\Compuware\License is the directory where the LM is 

located and license.dat is the name of your license file.(Your license.dat file may 

reside in \cpwr.)

3. Click Next. The Select Program Folder dialog box appears.

4. Create a folder named Compuware License Manager, place the shortcut in it, and 

click Next. The Select a Title for the Program dialog box appears.

5. In the Select a Title for the Program dialog box, type: Shutdown Compuware 

License Manager.

6. Click Finish, then click OK.

7. To stop the LM, select Start>Programs>Compuware License 

Manager>Shutdown Compuware License Manager.

Windows NT 

3.51

1. Highlight the QACenter icon and select File>New>Program Item. Click OK.

2. In the Description field, type: Shutdown Compuware License Manager

In the Command line field, type

c:\Program Files\Compuware\License\lmutil lmdown

where c:\Program Files\Compuware\License is the directory where the LM is 

located.(Your license.dat file may reside in \cpwr.)

3. Select the Run Minimized check box and click OK.

c:\Program Files\Compuware\License\lmutil lmdown -c

c:\Program Files\Compuware\License\license.dat
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4. Click on the new icon to shut down the LM Server. 

Installing a Concurrent-User License on UNIX
Complete the following tasks to install a permanent concurrent-user license:

� Install or update the LM. 

� Determine the host name and ID of the LM server.

� Obtain the permanent concurrent-user license.

� Enter the license information in the license file.

� Configure the LM for automatic startup.

� Configure each user workstation that will access the LM server.

� When necessary, perform manual shutdown of the LM.

Detailed instructions for performing these tasks are provided in this section.

Installing or Updating the License Manager

The machine on which a concurrent-user license is installed is called the LM server. It 

must always be available to workstations using Compuware products because it monitors 

product licensing. For more information, see “Selecting the Compuware License 

Manager Server” on page 9-8.

� If this is a first-time installation of the LM on this machine, go to “Installing the 

LM” on page 9-15.

� If a previous version of the LM is on this machine, you may need to install the cur-

rent version. Go to “Updating the LM” on page 9-15.

Installing the 

LM

The LM files for the supported UNIX platforms are located in platform-specific subdi-

rectories under /cpwr/cwlm on the QACenter CD-ROM.

1. On the machine where you intend to run the LM, create a directory named �cpwr/

license.

2. Copy the contents of the appropriate /cpwr/cwlm subdirectory from the QACenter 

CD-ROM to the directory you created in Step 1.

Updating the 

LM

If the LM is already installed, you may not need to install it again because it can be used 

for multiple Compuware products. Before you re-install the LM, check its version 

number to determine if it is the latest version available to you. To determine the version 

that is running on the LM server:
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c.
1. Change to the directory on the LM server where the LM is located.

2. Enter: ./lmutil lmver lmgrd. A message like the following displays the 

FLEXlm version number of the LM: 

3. Insert the QACenter CD in the CD-ROM drive. Change to the CD-ROM drive and 

enter lmutil lmver lmgrd again.

4. Compare the version number returned from the server with that on the CD-ROM:

• If the version number returned from the server is higher than the version on the 

CD-ROM (for example, if your LM version is 5.12 and that on the CD-ROM is 

5.0), do not update the LM.

• If the version number returned from the server is below that on the CD-ROM, 

you need to update your version of the LM.

5. To update the LM, copy the contents of the appropriate /cpwr/cwlm subdirectory 

from the CD-ROM to the directory where your current LM resides.

Determining the Host Name and ID

Once you install the LM, and before you can install the permanent license, you must 

supply Compuware with the host name and host ID of the LM server. To find these values, 

execute the following commands while signed onto the LM server:

1. Change to the directory in which the LM is located (for example, �cpwr/license).

2. To determine the host name, enter: uname -n. A message like the following is 

displayed: Host Name = fh5222dt

3. To determine the host ID, enter: lmutil lmhostid. A message like the following 

is displayed: The FLEXlm host ID of this machine is “00c04fd9ed02”.

Obtaining License Information

After you determine the host name and ID, contact your Compuware Sales Represen-

tative to obtain the required permanent concurrent-user license information. Compuware 

will provide you with the personalized license information by e-mail, fax, or regular mail.

Entering License Information

After you receive the permanent license from Compuware, complete the following 

procedure on the LM server.

lmutil - Copyright (C) 1989-1997 Globetrotter Software, Inc.
FLEXlm Copyright 1988-1996, Globetrotter Software, Inc.
FLEXlm 5.12a (libmgr_s.a), Copyright (C) 1988, 1997 Globetrotter Software,In
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1. Locate the license.dat file, which is normally in the directory where the LM is 

located. For information, see “Installing or Updating the License Manager” on page 

9-15.

• If the file does not exist, use a text editor to create a file named license.dat in 

the directory where the LM is located.

• If a license.dat file already exists for a Compuware product, use that file.

2. Open the license.dat file in a text editor.

3. If you received your license string via e-mail, paste your license string from the e-

mail into the license file. If not, type it into the license file. Commented information 

(preceded with a #) is for your reference only; you do not need to include it in the 

file.

• If you are entering the first license in the file: Enter the license information 

you received, as in the following example:

• If the license file is already used for a product: Append only the lines begin-

ning with FEATURE and ending with ck=##, where ## is a numeric string, to 

the end of the license file. For File-AID/CS, also include the PACKAGE line.

4. Save the license file.

5. Start the LM. From the directory where the LM is located, enter:

lmgrd -c �cpwr/license/license.dat

6. To verify the installation of the LM, enter: 

lmutil lmstat -a -c �cpwr/license/license.dat

 A list of product features from the FEATURE lines is displayed.

Configuring the License Manager for Automatic Startup

Because all license validation is done by the LM, it must be started and kept running in 

order to use Compuware products. Complete the appropriate procedure to automatically 

start the LM each time the LM server is started.

Caution

Enter the license information exactly as you received it. This information is case sensitive.

SERVER ServerName 0020af9adb94 TCP:7166
DAEMON compuware ./compuwar
FEATURE QARun Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\
VENDOR_STRING=989898;0;PERM ck=12
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Sun Solaris 1. In /etc/rc3.d, create a file named s95cwlm.server

2. Add the following command to the file:

nohup lmgrd -c �cpwr/license/license.dat >license.log &

SunOS Add the following command to /etc/rc.local:

nohup lmgrd -c �cpwr/license/license.dat >license.log &

HP-UX 1. In /sbin/rc3.d, create a file named s95cwlm.server

2. Add the following command to the file:

nohup lmgrd -c �cpwr/license/license.dat >license.log &

AIX 1. Add the following command to /etc/inittab:

rclocal:2:wait:/etc/rc.local >/dev/console/2 &1&

2. In /etc/rc.local, enter the following command on one line:

Configuring Each User Workstation

Each workstation on which the QACenter product will run with the concurrent-user 

license must be configured to access the LM. Complete the appropriate procedure on each 

workstation to set the LM_LICENSE_FILE environment variable.

Windows NT 4.x 1. From the Start menu, select Settings>Control Panel>System>Environment.

2. In the Variable field, type LM_LICENSE_FILE.

3. In the Value field, type 7166@hostname where hostname is the host name of the 

LM server. This value must match that of the first parameter of the SERVER line in 

the license file on the LM server (such as the ServerName value in Step 3 of 

“Entering License Information” on page 9-16).

4. Click the Set button. Reboot the machine for these changes to take effect.

Windows 95, 

98, or NT 3.51

1. Insert the QACenter CD in the CD-ROM drive. On the QACenter screen, click 

Install QACenter Products. On the Install QACenter Products screen, click Run 

License Administration Utility. The LAU opens.

2. From the Tools menu on the LAU main window, choose Set License Location.

nohup /etc/lmgrd -c �cpwr/license/license.dat >license.log 2 >&1&

Caution

Do not perform this procedure on Windows workstations if both the LM and the product 

are installed on UNIX and users will simply run the product from Windows. 
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3. Click the Browse button and navigate to LM server. Click Open to add the file to 

the LM_LICENSE_FILE variable.

4. Click OK. Reboot the machine for these changes to take effect.

Windows 3.1x 1. Using a text editor, open the autoexec.bat file and add the following line (with no 

spaces). Type the line exactly as you see it; this information is case sensitive.

set LM_LICENSE_FILE=7166@hostname

where hostname is the host name of the LM server. This value must match that of 

the first parameter of the SERVER line in the license file on the LM server.

2. Reboot the machine for these changes to take effect.

UNIX Set the LM_LICENSE FILE environment variable in each user profile file to either the 

path to the license.dat file or to a port on a host (such as 7166@hostname), as shown in 

either of these two examples:

Performing Manual Shutdown

On occasion, you may need to shut down the LM manually. Type the following command 

to shut down the LM:

�cpwr/license/lmutil lmdown

where �cpwr/license is the directory where the LM is located.

Installing a Concurrent-User License on Novell TCP/IP
Complete the following tasks to install a permanent concurrent-user license:

� Install or update the LM.

� Determine the host name and ID of the LM server.

� Obtain the permanent concurrent-user license. 

� Enter the license information in the license file.

� Configure the LM for automatic startup.

� Configure each user workstation that will access the LM.

� When necessary, perform manual shutdown of the LM.

Detailed instructions for performing these tasks are provided in this section.

setenv LM_LICENSE_FILE=/full path to license file/license.dat (csh)

-export LM_LICENSE_FILE=/full path to license file/license.dat (ksh)
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c.
Installing or Updating the License Manager

The machine on which a concurrent license is installed is called the LM server. It must 

always be available to workstations using Compuware products because it monitors 

product licensing. For more information, see “Selecting the Compuware License 

Manager Server” on page 9-8.

� If this is a first-time installation of the LM on this machine, go to “Installing the 

LM” on page 9-20.

� If a previous version of the LM is on this machine, you may need to install the cur-

rent version. Go to “Updating the LM” on page 9-20.

Installing the 

LM

Use the following procedure to complete a first-time installation of the LM:

1. On the Novell server where the LM will run, create a directory named \cpwr. This 

directory should be accessible from the Novell console after the server is booted.

2. Copy the following files from the \Cpwr\cwlm\Novell subdirectory on the 

QACenter CD-ROM to the \cpwr directory on the LM server:

• compuwar.nlm

• lmgr165c.dll

• lmutil.exe

• cwlmname.exe

Updating the 

LM

If the LM is already installed, you may not need to install it again because it can be used 

for multiple Compuware products. Before you re-install the LM, check its version 

number to determine if it is the latest version available to you. To determine the version 

that is running on the LM server:

1. Open a DOS window and change to the directory where the LM is located on the 

LM server.

2. At the DOS prompt, enter: lmutil lmver lmgrd.exe. A message like the 

following displays the FLEXlm version number of the LM: 

3. Insert the QACenter CD in the CD-ROM drive. Change to the CD-ROM drive and 

enter lmutil lmver lmgrd.exe again.

4. Compare the version number returned from the server with that on the CD-ROM:

• If the version number returned from the server is higher than the version on the 

CD-ROM (for example, if your LM version is 5.12 and that on the CD-ROM is 

5.0), do not update the LM.

lmutil - Copyright (C) 1989-1997 Globetrotter Software, Inc.
FLEXlm Copyright 1988-1996, Globetrotter Software, Inc.
FLEXlm 5.12a (libmgr_s.a), Copyright (C) 1988, 1997 Globetrotter Software,In
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• If the version number returned from the server is below that on the CD-ROM, 

you need to update your version of the LM.

5. To update the LM, copy the contents of the \cpwr\cwlm\Novell subdirectory on the 

QACenter CD-ROM to the directory where the current LM resides.

Determining the Host Name and ID

Once you install the LM, and before you can install the permanent license, you must 

supply Compuware with the host name and host ID of the LM server. To find these values, 

execute the following commands from the LM server:

1. To determine the host name, enter the name command while the server is running.

2. To determine the host ID, enter the config command while the server is running. 

As Note 1 in the following example shows, the host ID is the node address of the 

network adapter card. If the server has more than one network card, use the address 

of the first card as the host ID.

Ethernet Network Card Example: 

IPX Internal network number:347469c2

Node address: 000000000001

Frame type: VIRTUAL_LAN

LAN protocol: IPX network 347469c2

3Com EtherLink III 3c5x9 Family

Version 4.01b October 9, 1994

Hardware setting: I/P ports 300h to 30f, Interrupt Ah

Node address: 0020AF9ADB94   Note 1

Frame Type: ETHERNET_II

Board name: 3C5X9_1_II

Lan protocol: ARP

The TCP port_number must be set to 7166 for the LM. Also, the frame type of the server’s 

adapter (such as ethernet or token ring) must be either compatible with the client worksta-

tions or the same for the entire network.

Obtaining License Information

After you determine the host name and ID, contact your Compuware Sales Represen-

tative to obtain the required permanent concurrent-user license information. You can also 
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e-mail the information to license_mgt@compuware.com. Compuware will provide 

you with the personalized license information by e-mail, fax, or regular mail. 

Entering License Information

After you receive the permanent license from Compuware, complete the following 

procedure on the LM server.

1. Locate the license.dat file, which is normally in the directory where the LM is 

located. For information, see “Installing or Updating the License Manager” on page 

9-20.

• If the file does not exist, use a text editor such as Notepad to create a file named 

license.dat in the directory where the LM is located.

• If a license.dat file already exists for a Compuware product, use that file.

2. Open the license.dat file in a text editor.

3. If you received your license string via e-mail, paste your license string from the e-

mail into the license file. If not, type it into the license file. Commented information 

(preceded with a #) is for your reference only; you do not need to include it in the 

file.

• If you are entering the first license in the file: Enter the license information 

you received, as shown in the following example:

• If you already use the license file for a product: Append only the lines begin-

ning with FEATURE and ending with ck=##, where ## is a numeric string, to 

the end of the license file. For File-AID/CS, also include the PACKAGE line.

4. Save the license file.

5. To start the LM, perform the procedure below for either the Novell server console or 

the Novell remote console.

Note

When requesting a license, inform your Compuware Sales Representative that your LM 

server is running on a Novell platform using TCP/IP.

Caution

Enter the license information exactly as you received it. This information is case sensitive.

SERVER NOV4_1SV 0020af9adb94 TCP:7166
DAEMON compuware compuwar
FEATURE QARun Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\
VENDOR_STRING=989898;0;PERM ck=12
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.dat
• From the Novell server console, type:

where a:\cpwr\license indicates the A drive on the server, and license.dat is the 

name of your license file. After your entry, the license feature and the LM are dis-

played on the console.

• From the Novell remote console (Rconsole), type:

After your entry, the license feature and Compuware License Manager (license.dat) 

will be displayed on the console.

6. To verify the installation of the LM, enter: modules. Search the listing for the 

compuwar.nlm module.

Configuring the License Manager for Automatic Startup

Because all license validation is done by the LM, it must be started and kept running to 

use Compuware products. To automatically start the LM when the server is started, add 

the following command to the server’s autoexec.ncf file:

load c:\cpwr\license\compuwar.nlm -c c:\cpwr\license\license.dat

where c:\cpwr\license is the Novell server directory where the LM is located and 

license.dat is the name of your license file.

Configuring Each User Workstation

Each workstation running the QACenter product with a concurrent-user license must be 

configured to access the LM server.

1. Locate the packed files tli_spx.dll and tli_win.dll in the \public\client\doswin direc-

tory of the Novell server. Copy these files to the \windows or \windows\system 

load SYS(or vol name):\cpwr\license\compuwar.nlm -c SYS:\cpwr\license\license.dat

or

load a:\cpwr\license\compuwar.nlm -c a:\cpwr\license\license.dat

 load SYS(or vol name):\cpwr\license\compuwar.nlm -c SYS(or vol name):\cpwr\license\license

Note

For each client workstation, you must properly install and configure the TCP/IP protocol 

software supplied by Microsoft. After the TCP/IP protocol is installed and configured, 

each workstation should be able to map to the Novell server’s drive.
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directory. Unpack the files with the nwnpack.exe utility, which is in the same Novell 

directory. Compuware cannot provide these files, they must be supplied by Novell.

2. On each workstation, use the appropriate procedure to set the LM_LICENSE_FILE 

environment variable.

Windows NT 4.x:

a. Select Control Panel>System>Environment.

b. In the Variable field, type LM_LICENSE_FILE.

c. In the Value field, type 7166@hostname where hostname is the host name of 

the LM server. This value must match that of the first parameter of the 

SERVER line in the license file on the LM server (such as the ServerName 

value in Step 3 of “Entering License Information” on page 9-22).

d. Click the Set button. For best results, reboot the machine.

e. Optional: If you are using IPX/SPX and need to change to the TCP/IP proto-

col, you may need to set the following environment variable:

FLEXLM_COMM_TRANSPORT=TCP

By default, the LM will use the TCP/IP protocol.

Windows 3.1x, 95, 98, or NT 3.51:

a. Using a text editor such as Notepad, open the autoexec.bat file.

b. Add the following line with no spaces. Type the line exactly as you see it; this 

information is case sensitive. 

set LM_LICENSE_FILE=7166@hostname

where hostname is the host name of the LM server. This value must match 

that of the first parameter of the SERVER line in the license file on the LM 

server (such as the ServerName value in Step 3 of “Entering License Informa-

tion” on page 9-22).

c. Reboot the machine for these changes to take effect.

Shutting Down the License Manager

On occasion, you may need to manually shut down the LM. To do so, type the unload

compuwar.nlm command from the Novell console: 

Installing a Concurrent-User License on Novell IPX/SPX
Complete the following tasks to install a permanent concurrent-user license:

� Install or update the LM.
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� Determine the host name and ID of the LM server.

� Obtain the permanent concurrent-user license.

� Enter the license information in the license file.

� Configure the LM for automatic startup.

� Configure each user workstation that will access the LM.

� When necessary, perform manual shutdown of the LM.

Detailed instructions for performing these tasks are provided in this section.

Installing or Updating the License Manager

The machine on which a concurrent license is installed is called the LM server. It must 

always be available to workstations using Compuware products because it monitors 

product licensing. For more information, see “Selecting the Compuware License 

Manager Server” on page 9-8.

� If this is a first-time installation of the LM on this machine, go to “Installing the 

LM” on page 9-25.

� If a previous version of the LM resides on this machine, you may need to install the 

current version. Go to “Updating the LM” on page 9-25.

Installing the 

LM

Use the following procedure to complete a first-time installation of the LM:

1. On the Novell server where the LM will run, create a directory named \cpwr. This 

directory should be accessible from the Novell console after the server is booted. 

2. Copy the following files from the \Cpwr\cwlm\Novell subdirectory on the CD to the 

directory you created in Step 1:

• compuwar.nlm

• lmgr165c.dll

• lmutil.exe

• cwlmname.exe

3. In the \cpwr directory, use a text editor to create a file named license.dat.

Updating the 

LM

If the LM is already installed, you may not need to install it again because it can be used 

for multiple Compuware products. Before you re-install the LM, check its version 

number to determine if it is the latest version available to you. To determine the version 

that is running on the LM server:

Note

You must have version 5.00q or higher of spxs.nlm installed on the license server for the 

LM to function properly. This file must be supplied by Novell. You can find version 5.00q 

of spxs.nlm at www.novell.com. Apply it using the Novell Filer command.
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c.
1. Open a DOS window and change to the directory where the LM is located on the 

LM server.

2. At the DOS prompt, enter: lmutil lmver lmgrd.exe. A message like the 

following displays the FLEXlm version number of the LM: 

3. Insert the QACenter CD in the CD-ROM drive. Change to the CD-ROM drive and 

enter lmutil lmver lmgrd.exe again.

4. Compare the version number returned from the server with that on the CD-ROM:

• If the version number returned from the server is higher than the version on the 

CD-ROM (for example, if your LM version is 512 and that on the CD-ROM is 

5.0), do not update the LM.

• If the version number returned from the server is below that on the CD-ROM, 

you need to update your version of the LM.

5. To update the LM, copy the contents of the \cpwr\cwlm\Novell subdirectory on the 

QACenter CD-ROM to the directory where the current LM resides. 

Determining the Host Name and ID

Once you install the LM, and before you can install the permanent license, you must 

supply Compuware with the host name, host ID, node_address, and the network_number 

of the Novell LM server.

1. To determine the host name, enter the name command while the server is running. 

2. To determine the host ID, node_address, and network_number, enter the config 

command while the server is running. Notes 1, 2, and 3 in the following examples 

indicate the location of these values: 

• Note 1: The host ID is the node address of the adapter (such as ethernet or 

token ring). If the server has more than one network card, use the first card’s 

address as the host ID.

• Note 2: The node_address is the node address of the LM server. The 

node_address has a default setting of 000000000001. If the config command 

shows a node_address other than the default, use the value you see.

lmutil - Copyright (C) 1989-1997 Globetrotter Software, Inc.
FLEXlm Copyright 1988-1996, Globetrotter Software, Inc.
FLEXlm 5.12a (libmgr_s.a), Copyright (C) 1988, 1997 Globetrotter Software,In
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• Note 3: The network_number is the IPX internal network number. 

Ethernet network Card Example: 

IPX Internal network number:347469c2 Note 3

Node address: 000000000001 Note 2

Frame type: VIRTUAL_LAN

LAN protocol: IPX network 347469c2

3Com EtherLink III 3c5x9 Family

Version 4.01b October 9, 1994

Hardware setting: I/P ports 300h to 30f, Interrupt Ah

Node address: 0020AF9ADB94 Note 1

Frame Type: ETHERNET_802.2

Board name: 3C5X9_1E82

Lan protocol: IPX Network

PCI LAN Network Card Example: 

File server name: MY-Y2K_7TOWER

IPX internal network number: B00101176 Note 3

HP 10/100TX PCI LAN Adapter

version 1.48 September 5, 1996

Hardware setting: Slot 32, I/O port ECE0h to ECFFh, MEM
FFFFH,

Interrupt Ah

Node address: 0060B0577B88 Note 2 , Note 1

Frame type: ETHERNET_802.3

Board name: ETH_BB1

LAN protocol: IPX network C0010113

My_Y2K_7TOWER: 

Token Ring Network Card Example: 

IPX Internal network number: ACF04A00 Note 3

Node address: 000000000001 Note 2

Frame type: VIRTUAL_LAN

LAN protocol: IPX network ACF04A00

Note

The adapter’s frame type of the server must be either compatible with the client 

workstations or it must be the same in the entire network. 

 Socket_Number: Compuware uses 1234 as the default socket_number unless you 

provide a different number. Note that the socket_number of the LM server must be 

between 0001 and 9999 and must be unique to the server. 
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IBM PCI Token Ring Adapter Hardware Specific Module

Version 1.13 January 5, 1998

Hardware Setting: Slot 1, Memory FEAFFC00H to FEAFFCFFh

Node address: 000629179757 Note 1

Frame type: TOKEN-RING

Board name: IBMTRP0_1_TOK

Lan protocol: IPX network 00000060

Obtaining License Information

After you determine the host name, host ID, node_address, and IPX/SPX internal 

network_number, contact your Compuware Sales Representative to obtain the required 

permanent concurrent-user license information. You can also e-mail the information to 

license_mgt@compuware.com. Compuware will provide you with the personalized 

license information by e-mail, fax, or regular mail. 

Entering License Information

After you receive the permanent license from Compuware, complete the following 

procedure on the LM server.

1. Locate the license.dat file, which is normally in the directory where the LM is 

located, or in the \cpwr directory on the client workstation (depending on where you 

created the license file). For information, see “Installing or Updating the License 

Manager” on page 9-20.

• If the file does not exist, use a text editor such as Notepad to create a file named 

license.dat in the directory where the LM is installed or in the \cpwr directory 

on the client workstation.

• If a license.dat file already exists for a Compuware product, use that file.

2. Open the license.dat file in a text editor.

3. If you received your license string via e-mail, paste your license string from the e-

mail into the license file. If not, type it into the license file. Note that File-AID/CS 

also requires a PACKAGE statement. Commented information (preceded with a #) 

is for your reference only; you do not need to include it in the file.

Note

When requesting a license, inform your Compuware Sales Representative that your 

license server will be running on a Novell platform using IPX/SPX.

Caution

Enter the license information exactly as you received it. This information is case sensitive.
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.dat
• If the first license is being entered in the file: Enter the license information 

you received, as shown in the following example:

• If a license file is already used for a product: Append only the lines begin-

ning with FEATURE and ending with ck=##, where ## is a numeric string, to 

the end of the license file. For File-AID/CS, also include the PACKAGE line.

4. Save the license file.

5. To start the LM, perform the procedure below for either the Novell server console or 

the Novell remote console.

• From the Novell server console, type:

where a:\cpwr\license indicates the A drive on the server, and license.dat is the 

name of your license file. After your entry, the license feature and the LM are dis-

played on the console.

• From the Novell remote console (Rconsole), type:

After your entry, the license feature and Compuware License Manager (license.dat) 

will be displayed on the console.

6. To verify the installation of the LM, enter: modules. Search the listing for the 

compuwar.nlm module.

Configuring the License Manager for Automatic Startup

Because all license validation is done by the LM, it must be started and kept running in 

order to use the QACenter product. The LM must be started on the machine where it was 

installed. To automatically start the LM when the server is started, add the following 

command to the server’s autoexec.ncf file:

load c:\cpwr\license\compuwar.nlm -c c:\cpwr\license\license.dat

where c:\cpwr\license is the Novell server directory where compuwar.nlm is located 

and license.dat is the name of your license file.

SERVER NOV4_1SV 0020af9adb94 SPX:1234@000000000001 347469c2
DAEMON compuware compuwar
FEATURE QARun Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\
VENDOR_STRING=989898;0;PERM ck=12

load SYS(or vol name):\cpwr\license\compuwar.nlm -c SYS:\cpwr\license\license.dat

or

load a:\cpwr\license\compuwar.nlm -c a:\cpwr\license\license.dat

 load SYS(or vol name):\cpwr\license\compuwar.nlm -c SYS(or vol name):\cpwr\license\license
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Configuring Each User Workstation

Each workstation on which you want to run the QACenter product with the concurrent-

user license must be configured to access the LM.

Windows NT 4.x 1. Configure the IPX/SPX protocol on each client workstation using the appropriate 

procedure:

• Install the IPX/SPX protocol using Microsoft’s Novell NetWare client.

• Install Novell Client 4.11a, which you can download from www.novell.com.

2. Check that the following files are in the \windows\system or \system32 directory. If 

Novell Client V4.11a is installed, these files should have been automatically copied 

to this directory. If they are not, copy them from the \public\client\doswin directory 

on the Novell CD-ROM or the Novell server. Unpack them with the nwunpack.exe 

utility, which is in the same Novell directory.

• nwcalls.dll (\System)

• nwipxspx.dll (\System32)

• nwlocale.dll (\System)

• nwnet.dll (\System)

• tli_spx.dll (\System)

• tli_win.dll (\System)

3. From the Start menu, select Control Panel>System>Environment.

4. In the Variable field, type LM_LICENSE_FILE.

5. In the Value field, type: 

c:\cpwr\license\license.dat

where c:\cpwr\license is the directory where your license file is located and 

license.dat is the name of your license file. This value should be the mapped loca-

tion on the server, but it can be a local file with the same information.

6. Click the Apply button.

7. In the Variable field, type FLEXLM_COMM_TRANSPORT.

8. In the Value field, type SPX.

9. Click the Apply button.

10. Reboot the machine.

Windows 95, 

98, or NT 3.51

1. Configure the IPX/SPX protocol on each client workstation using the appropriate 

procedure:

• Install the IPX/SPX protocol using Microsoft’s Novell NetWare Client and the 

IPX/SPX-compatible protocol.

• Install Novell Client V2.5, which you can download from www.novell.com.
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2. Check that the following files are in the windows\system directory. If Novell Client 

V2.5 or above is installed, these files should have been automatically copied to this 

directory. If they are not, copy them from the \public\client\doswin directory on the 

Novell CD-ROM or the Novell server. Unpack them with the nwunpack.exe utility, 

which is in the same Novell directory.

• nwipxspx.dll

• nwcalls.dll

• tli_spx.dll

• tli_win.dll

• nwlocale.dll

• nwnet.dll 

3. Using a text editor, open the autoexec.bat file and add the following two lines. Type 

the lines exactly as you see then; this information is case sensitive.

set LM_LICENSE_FILE=c:\cpwr\license\license.dat

set FLEXLM_COMM_TRANSPORT=SPX

where c:\cpwr\license is the directory where your license file is located and 

license.dat is the name of your license file. This should be the mapped location 

on the server, but it can be a local file with the same information.

4. Reboot the machine.

Windows 3.1x 1. Install and configure the IPX/SPX protocol software supplied by Novell.

2. Using a text editor, open the autoexec.bat file and add the following two lines. Type 

the lines exactly as you see them; this information is case sensitive. 

set LM_LICENSE_FILE=c:\cpwr\license\license.dat

set FLEXLM_COMM_TRANSPORT=SPX

where c:\cpwr\license is the directory where your license file is located and 

license.dat is the name of your license file. This value can be the mapped loca-

tion on the server, or optionally, the local file with the same information. 

3. Reboot the machine.

Shutting Down the License Manager Manually

On occasion, you may need to manually shut down the LM. To do so, type the unload

compuwar.nlm command from the Novell console.
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